
TekExpress® SFP+ QSFP+ Tx
Compliance and Debug Solution Software
Application Help

*P077059006*
077-0590-06





TekExpress® SFP+ QSFP+ Tx
Compliance and Debug Solution Software
Application Help

Register now!
Click the following link to protect your product.
www.tek.com/register

*P077059006*
077-0590-06



Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its subsidiaries or suppliers, and are
protected by national copyright laws and international treaty provisions. Tektronix products are covered by U.S. and foreign patents, issued
and pending. Information in this publication supersedes that in all previously published material. Specifications and price change privileges
reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.

Contacting Tektronix
Tektronix, Inc.

14150 SW Karl Braun Drive

P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:

• In North America, call 1-800-833-9200.
• Worldwide, visit to www.tek.com find contacts in your area.

HTTP://www.tek.com


Table of Contents
Welcome....................................................................................................................................................................................... 9
Getting help and support............................................................................................................................................................. 11

Product documents.............................................................................................................................................................. 11
Conventions......................................................................................................................................................................... 11
Technical support................................................................................................................................................................. 12

Getting started.............................................................................................................................................................................13
Hardware requirements....................................................................................................................................................... 13

Minimum system requirements.....................................................................................................................................13
Supported instruments..................................................................................................................................................13

Software requirements.........................................................................................................................................................14
Downloading and installing the software.......................................................................................................................14
Activate the license.......................................................................................................................................................14
View software version and license key details..............................................................................................................14

Setting up the test environment.................................................................................................................................................. 16
Setting up tests.................................................................................................................................................................... 16
Instrument connection setup................................................................................................................................................17

Connection setup for host tests.................................................................................................................................... 18
Connection setup for module tests............................................................................................................................... 21

Test setup overview............................................................................................................................................................. 22
Search instruments connected to the application................................................................................................................ 22
Running tests....................................................................................................................................................................... 23
Before you click start............................................................................................................................................................23
Pre-run checklist.................................................................................................................................................................. 24

Starting the application................................................................................................................................................................26
Application controls..............................................................................................................................................................27
Options menu functions....................................................................................................................................................... 28
Configure email settings...................................................................................................................................................... 30
TekExpress instrument control settings............................................................................................................................... 31

Setup panel: Configure the test setup.........................................................................................................................................32
DUT: Set DUT settings.........................................................................................................................................................34
Test Selection: Select the tests............................................................................................................................................ 36
Acquisitions: Set waveform acquisition settings.................................................................................................................. 37
Configuration: Set measurement limits for tests.................................................................................................................. 39
Preferences: Set the test run preferences........................................................................................................................... 42

Status panel: View the test execution status...............................................................................................................................43
View test execution status....................................................................................................................................................43
View test execution logs.......................................................................................................................................................44

Results panel: View summary of test results...............................................................................................................................45
Filter the test results.............................................................................................................................................................45

Reports panel: Configure report generation settings.................................................................................................................. 47
Select report generation options.......................................................................................................................................... 47
View a generated report.......................................................................................................................................................50

Saving and recalling test setup................................................................................................................................................... 51
Overview.............................................................................................................................................................................. 51

Table of Contents

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 5



Save the configured test setup............................................................................................................................................ 51
Load a saved test setup.......................................................................................................................................................52
Perform a test using pre-run session files............................................................................................................................53
Save the test setup with a different name............................................................................................................................ 57
Run a saved test in prerecorded mode................................................................................................................................57

SCPI Commands........................................................................................................................................................................ 59
About SCPI command......................................................................................................................................................... 59
Socket configuration for SCPI commands........................................................................................................................... 59
Set or query the device name of application........................................................................................................................65
Set or query the suite name of the application.....................................................................................................................65
Set or query the test name of the application...................................................................................................................... 66
Set or query the version name of the application.................................................................................................................68
Set or query the general parameter values..........................................................................................................................68
Set or query the acquire parameter values..........................................................................................................................70
Set or query the analyze parameter values......................................................................................................................... 74
Query the available devices in the DUT panel of the application.........................................................................................74
Query the available suites for the selected device...............................................................................................................75
Query the list of available tests of the application................................................................................................................75
Query the available version names of the application......................................................................................................... 76
Query the list of available instruments based on the specified instrument type...................................................................77
Set or query the IP address of the instrument based on the specified instrument type.......................................................77
Query the information of the generated report file............................................................................................................... 77
Query the information of the generated waveform files....................................................................................................... 78
Query the information of the generated image files............................................................................................................. 78
Query the active TekExpress application name................................................................................................................... 79
Set or query the DUTID of application................................................................................................................................. 79
Sets or query the acquire mode status................................................................................................................................ 79
Set or query the execution mode status.............................................................................................................................. 80
Generate the report for the current session......................................................................................................................... 80
Query the value of specified report header field in the report.............................................................................................. 81
Query the value of specified result detail available in report summary/details table............................................................81
Restore the setup to default settings................................................................................................................................... 82
Save the setup..................................................................................................................................................................... 82
Save the settings to a specified session.............................................................................................................................. 82
Open the setup from a specified session.............................................................................................................................83
Query the current setup file name........................................................................................................................................83
Run/stop/pause/resume the selected measurements execution in the application............................................................. 83
Query the current measurement execution status............................................................................................................... 84
Query whether the current setup is saved or not saved...................................................................................................... 84
Exit or close the application................................................................................................................................................. 84
Query the status of the previous command execution.........................................................................................................84
Query the last error occurred............................................................................................................................................... 85
Set or query the popup details............................................................................................................................................. 85
Sets or query the limit values in the limits editor window.....................................................................................................85
Set or query the waveform file recalled for the specified test name and acquire type.........................................................86
Set or query the enable/disable status of Verbose function.................................................................................................86
Query the enable or disable status of Continuous run function........................................................................................... 87
Set or query the enable/disable status of Continuous Run function.................................................................................... 87
Set or query the continuous run duration time value........................................................................................................... 88

Table of Contents

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 6



Set or query the session create option in the continuous run function................................................................................ 88
Set or query the View report after generating option status.................................................................................................89
Returns the report as XML string......................................................................................................................................... 90
Copies all the images from current run session to the given destination location................................................................90
Selects the specified test(s) and deselect all other tests..................................................................................................... 90
Returns the complete information about the selected test...................................................................................................91
Set the default session.........................................................................................................................................................91
Save the run/config sessions............................................................................................................................................... 91
Load the run/config session................................................................................................................................................. 91
Delete the run/config session...............................................................................................................................................92
Run the run/config saved session........................................................................................................................................92
Query the available list in the run/config session.................................................................................................................92
Query the current run/config session................................................................................................................................... 93
Override the run/config session........................................................................................................................................... 93

SFP+ QSFP+ Tx tests.................................................................................................................................................................94
Testing procedures and examples....................................................................................................................................... 94

Signal types used by tests............................................................................................................................................ 94
Oscilloscope setup........................................................................................................................................................95
Signal validation procedure.......................................................................................................................................... 95

Host test: SFF-8431 table 11 tests.......................................................................................................................................96
Single-ended output voltage range...............................................................................................................................96
Output AC Common-Mode voltage (RMS) (Host).........................................................................................................96

Host test: SFF-8431 table 12 tests...................................................................................................................................... 97
Crosstalk source Rise/Fall time (20% - 80%) (Host).....................................................................................................97
Crosstalk source amplitude (p-p differential) (Host)......................................................................................................98
Signal Rise/Fall time (20% - 80%)................................................................................................................................ 98
Total jitter (Host)............................................................................................................................................................99
Data dependent jitter (Host)........................................................................................................................................101
Data dependent pulse width shrinkage (Host)............................................................................................................102
Uncorrelated jitter (Host).............................................................................................................................................103
Transmitter Qsq.......................................................................................................................................................... 104
Eye mask hit ratio (Host).............................................................................................................................................105

Host test: SFF-8431 table 33 tests.................................................................................................................................... 107
Voltage modulation amplitude (p-p)............................................................................................................................ 107
Transmitter Qsq (for Cu)............................................................................................................................................. 107
Output AC Common-Mode voltage (RMS) (for Cu).................................................................................................... 108
Host output TWDPc.................................................................................................................................................... 109

Module test: SFF-8431 table 16 tests................................................................................................................................ 110
AC Common-Mode voltage tolerance (Module)..........................................................................................................110
Single-Ended input voltage tolerance (Module).......................................................................................................... 110

Module test: SFF-8431 table 17 tests.................................................................................................................................111
Crosstalk source Rise/Fall time (20% - 80%) (Module)...............................................................................................111
Crosstalk source amplitude (p-p differential) (Module)............................................................................................... 112
Output AC Common-Mode voltage (RMS) (Module).................................................................................................. 112
Total jitter (Module)......................................................................................................................................................113
Data dependent jitter (Module)....................................................................................................................................114
Data dependent pulse width shrinkage (Module)........................................................................................................116
Uncorrelated jitter (Module).........................................................................................................................................116
Eye mask hit ratio (Module)........................................................................................................................................ 117

Table of Contents

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 7



References................................................................................................................................................................................120
Application directories........................................................................................................................................................120
File name extensions......................................................................................................................................................... 121
View test-related files......................................................................................................................................................... 121
De-embed using filter files................................................................................................................................................. 122
Deskew channels...............................................................................................................................................................122
Map the My TekExpress folder...........................................................................................................................................123

Index......................................................................................................................................................................................... 124

Table of Contents

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 8



Welcome
TekExpress is the Tektronix Test Automation Framework, developed to support your current and future test automation needs. TekExpress
uses a highly modular architecture that lets you deploy automated test solutions for various standards in a relatively short time.

Note: The skew between Data+ and Data- in the signal path from the DUT to the oscilloscope will be computed and compensated
before running the measurements.

Key Features

• Allows conformance testing to the latest Compliance Test Specification (CTS)
• Reliable Testing:

• Conformance to SFP+ and QSFP+ interconnect module electrical testing ensures reliable results
• SFP+ QSFP+ Tx is SFP+ and QSFP+ compliance software
• Enables execution of the physical-layer (PHY), electrical tests, and SFP+/QSFP+ based electrical measurements

• Automated testing:

• Minimizes user intervention when conducting time-consuming testing
• Reduces the time required to conduct testing

• Selective testing:

• Performs fully-automated testing for transmitter measurements
• Allows you to select individual tests or test groups in the tree-structure
• Avoids repeated testing through accurate and reliable results from a single run

• Quick testing:

• One-button selection of multiple tests ensures faster testing
• Test margins and statistical information aid analysis to find answers quickly

Welcome
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• One-button .mht report saves time
• Complete Solution:

• Wide range of tests for SFP+/QSFP+ Host devices and SFP+/QSFP+ Module devices enables complete validation
• Complete compliance solution with an elaborate test fixture and signal sources support for SMA cable-based solution provides

cost-effective way to perform compliance testing
• User defined mode supports PRBS7, PRBS11, PRBS15, PRBS20 and PRBS23 in addition to patterns supported in Compliance

mode including PRBS9, PRBS31 and 8180
• Customize the setup:

• Modify the test setup according to the DUT configuration.
• Run test measurements with different record lengths.
• Run test measurements with more than one signal.

• Detailed test reporting:

• Provides a Pass/Fail summary table
• Provides margin details on each test
• Provides a consolidated report for all tests
• Provides additional information such as skew and signal type selected for each measurement

Welcome
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Getting help and support
Product documents
Use the product documents for more information on the application functions, understand the theory of operation, how to remotely program
or operate the application, and do other tasks.

Table 1: TekExpress Application documents

To learn about Use this document
How to use the application

How to remotely control the instrument
TekExpress SFP+ QSFP+ Help

PDF version of this document can be downloaded from www.tek.com/downloads

Compiled HTML (CHM) version is integrated with the application. Press F1 key from the
keyboard to start the help.

Tektronix Part Number: 077-xxxx-xx

Conventions
This application help uses the following conventions:

• The term "Application," and "Software" refers to the TekExpress SFP+ QSFP+ application.
• The term “DUT” is an abbreviation for Device Under Test.
• The term “select” is a generic term that applies to the two methods of choosing a screen item (button control, list item): using a mouse

or using the touch screen.
• A Note identifies important information.

Table 2: Icons used in the help

Icon Description
This icon identifies important information

This icon identifies conditions or practices that could result in loss of data.

This icon identifies additional information that will help you use the application more
efficiently.

Getting help and support
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Technical support
Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or comments on
your application or oscilloscope. Contact Tektronix through mail, telephone, or the Web site. See Contacting Tektronix at the front of this
document for contact information.

When you contact Tektronix Technical Support, please include the following information (be as specific as possible): 

General information
• All instrument model numbers
• Hardware options, if any
• Modules used
• Your name, company, mailing address, phone number, FAX number
• Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information
• Software version number
• Description of the problem such that technical support can duplicate the problem
• If possible, save the setup files for all the instruments used and the application
• If possible, save the TekExpress setup files, log.xml, *.TekX (session files and folders), and status messages text file

Getting help and support
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Getting started
Hardware requirements

Minimum system requirements
The following table describes the minimum system requirements for the TekExpress SFP+ QSFP+ application.

Table 3: Minimum system requirements

Instruments Description
Processor Same as the oscilloscope
Operating System Same as the oscilloscope (Windows 7, 64-bit only)
Memory Same as the oscilloscope
Hard Disk Same as the oscilloscope
Display Same as the oscilloscope 1

Firmware TekScope 10.3.3 for non-SX series digital oscilloscopes

TekScope 10.3.0 for SX series digital oscilloscopes

Software • DPOJET, Jitter and Eye Diagram Analysis Tool, version 10.0.0.35 or later (64-bit)
• MathWorks MATLAB Runtime 8.0 2 (Windows 7)
• IronPython 2.7.3
• PyVisa 1.0.0.25
• Microsoft .NET 4.0 Framework
• Microsoft Internet Explorer 6.0 SP1 or later
• Microsoft Photo Editor 3.0 or equivalent software for viewing image files
• Adobe Reader 7.0 or equivalent software for viewing portable document format (PDF) files

Other Devices • Microsoft compatible mouse or compatible pointing device
• Four USB ports (two USB ports minimum)
• PCI-GPIB or equivalent interface for instrument connectivity 3

Supported instruments
The TekExpress SFP+ QSFP+ Tx application runs on the following Tektronix oscilloscopes:

• DPO/DSA/MSO71604C and DPO/DSA/MSO72004C Series Digital Oscilloscopes
• DPO/DSA72504D and DPO/DSA73304D Series Digital Oscilloscopes
• DPO/MSO72304DX, DPO/MSO72504DX, and DPO/MSO73304DX Series Digital Oscilloscopes
• DPO70000SX Series Digital Oscilloscopes

1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, a sampling oscilloscope), it is recommended that you connect
a secondary monitor, which must be enabled before launching the application.

2 MatLab Runtime Compiler is required for performing the Host Output TWDPc test. This test is purchase option SFP-WDP.
3 If TekExpress is installed on a Tektronix oscilloscope, TekExpress will use the virtual GPIB port for communicating with oscilloscope applications. If external GPIB

communication devices such as USB-GPIB-HS or equivalent are used for instrument connectivity, make sure that the Talker Listener utility is enabled in the GPIB
menu of the DPO/DSA oscilloscope. For ease of use, connect to an external (secondary) monitor.

Getting started
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See also
Minimum system requirements on page 13

Software requirements

Downloading and installing the software
Complete the following steps to download and install the latest TekExpress SFP+ QSFP+ application.

1. Go to www.tek.com.
2. Click Downloads. In the Downloads menu, select DOWNLOAD TYPE as Software and enter the application name in the MODEL OR

KEYWORD field and click SEARCH.

3. Select the latest version of software and follow the instructions to download the software. Copy the executable file into the
oscilloscope.

4. Double-click the executable and follow the on-screen instructions.

The software is installed at C:\Program Files\Tektronix\TekExpress\TekExpress SFP+ QSFP+.
5. Select Application > TekExpress SFP+ QSFP+ from the Oscilloscope menu, to open the application.

Activate the license
Activate the license using the Option Installation wizard in the TekScope application:

1. In the TekScope application menu bar, click Utilities > Option Installation. The TekScope Option Installation wizard opens.
2. Push the F1 key on the oscilloscope keyboard to open the Option Installation help topic.
3. Follow the directions in the help topic to activate the license.

View software version and license key details
To view version information of the application, click Options > About TekExpress.

Getting started
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Setting up the test environment
Setting up tests
Set up tests using the tabs in the Setup panel. Settings in the DUT tab use a top-down, left-to-right logic flow, so that any parameter that
affects or acts as a filter for other parameters appears either above or to the left of the affected parameters.

Test options: standards, views, and modes
Test options include two standards, QSFP+ Tx and SFP+ Tx (selected in the DUT tab of the Setup panel), two views, Compliance and
Advanced (selected in the DUT tab of the Setup panel), and two modes, Compliance and User Defined (selected in the configuration
settings of the Setup panel).

The selected standard determines which measurement standard will be used. The selected view determines where the test configuration
settings are displayed. The selected mode determines whether you can change test configuration settings to include those that are
noncompliant.

• Compliance View selected with Compliance Mode

View configuration options in the Test Selection tab of the Setup panel. Tests will run automatically with little or no user intervention.
You will not be able to change test parameters to anything that deviates from the compliance standards. The only test configuration
parameters that you can change in this mode are the Global Settings.

• Compliance View selected with User-Defined Mode

View configuration options in the Test Selection tab of the Setup panel. Tests will run automatically but you will be able to change the
parameters before starting the tests.

• Advanced View selected with Compliance Mode

View configuration options in the Configuration tab of the Setup panel. Tests will run automatically with little or no user intervention. You
will not be able to change test parameters to anything that deviates from the compliance standards. The only configuration parameters
that you can change in this mode are the Global Settings.

• Advanced View selected with User-Defined Mode

View configuration options in the Configuration tab of the Setup panel. Tests will run automatically but you will be able to change test
parameters before starting the tests.

Supported tests
The application supports the following tests, grouped by profile.

Host Profile Tests

• SFF-8431 Table 11 Output Electrical Specifications at B:

• Single Ended Output Voltage Range
• Output AC Common Mode voltage (RMS)

• SFF-8431 Table 12 Jitter and Eye Mask Specifications at B:

• Crosstalk Source Rise/Fall Time (20%–80%)
• Crosstalk Source Amplitude (p-p Differential)
• Signal Rise/Fall Time (20%–80%)
• Total Jitter
• Data Dependent Jitter
• Data Dependent Pulse Width Shrinkage
• Uncorrelated Jitter
• Transmitter Qsq

Setting up the test environment

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 16



• Eye Mask Hit Ratio
• SFF-8431 Table 33 Output Specifications at B for Cu:

Note: The group SFF-8431 Table 33 Output Specifications at B for Cu is associated with the 10GSFP+ Cu Direct Attach
Cable device profile (the check box for this profile is located on the DUT tab of the Setup panel). This group of tests is
available only when this check box is selected.

• Voltage Modulation Amplitude (p-p)
• Transmitter Qsq (for Cu)
• Output AC Common Mode voltage (RMS) (for Cu)
• Host Output TWDPc

Note: An evaluation version of the Host Output TWDPc test is included in the SFP+ QSFP+ Tx installation. You are
allowed 10 free trials of this test. Each time you run the test, regardless of how often you open the application, one of the
free trials is used. To use this test after the evaluation period, purchase the SFP-WDP option license key.

Module Profile Tests

• SFF-8431 Table 16 Transmitter Input Electrical Specifications at B:

• AC Common-Mode Voltage Tolerance
• Single-Ended Input Voltage Tolerance

• SFF-8431 Table 17 Transmitter Input Tolerance Signal Calibrated at B:

• Crosstalk Source Rise/Fall Time (20%-80%)
• Crosstalk Source Amplitude (p-p Differential)
• Output AC Common-Mode Voltage (RMS)
• Total Jitter
• Data Dependent Jitter
• Data Dependent Pulse Width Shrinkage
• Uncorrelated Jitter
• Eye Mask Hit Ratio

• Additional Supported Measurements for QSFP+ only

• Total Jitter @ J2
• Total Jitter @ J9

Instrument connection setup
To run tests, you need the following instrument (for details, see Minimum System Requirements):

• A supported Tektronix oscilloscope.
• The device under test
• SFP+ or QSFP+ fixtures

Table 4: SFP+ and QSFP+ fixtures

Tektronix nomenclature Description
TF-SFP-TPA-HCB-P SFP+ Host Compliance Board Plug
TF-SFP-TPA-MCB-R SFP+ Module Compliance Board Receptacle
TF-SF-TPA-PR SFP+ Host Compliance Board Plug and Module Compliance Board Receptacle
Table continued…

Setting up the test environment
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Tektronix nomenclature Description
TF-SFP-TPAHCB-PK SFP+ Host Compliance Board Plug Kit with DC Blocks and Termination
TF-SFP-TPAMCB-RK SFP+ Module Compliance Board Receptacle Kit with DC Block and Termination
TF-SFP-TPA-PRK SFP+ Host Module Compliance Board and Module Compliance Board with DC Blocks and

Termination
TF-QSFP-TPAHCB-P QSFP+ Host Compliance Plug
TF-QSFP-TPAMCB-R QSFP+ Module Compliance Board Receptacle
TF-QSFP-TPA-PR QSFP+ Host Compliance Board Plug and Module Compliance Board Receptacle
TF-DC-BLOCK-KIT DC Block Kit

Equipment connections can vary by Device Profile (Host and Module) and by individual test. Refer to the following connection diagrams
when setting up equipment for testing.

Connection setup for host tests
• Table 12 Crosstalk Source tests

• All other Host tests

Setting up the test environment
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Test setup for all measurements other than single-ended output voltage range
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Test setup for single ended output voltage range measurement on DPO/DSA70000D series oscilloscopes

Setting up the test environment
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Test setup for single ended output voltage range measurement on all oscilloscopes other than DPO/DSA70000D series oscilloscopes

Connection setup for module tests
• Single-Ended Input Voltage Tolerance Test

• All other Module tests

Setting up the test environment
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Test setup overview
A test setup includes configuration parameters and report options. Use the options in the Setup panel and Reports panel to select and
configure tests.

1. Select the DUT parameters
2. Select one or more tests
3. Select acquisitions
4. Configure test parameters
5. Select test notification preferences
6. Select report options

Search instruments connected to the application
Use the TekExpress Instrument Control Settings dialog box to search the instruments (resources) connected to the application. The
application uses TekVISA to discover the connected instruments.

Note: The instruments required for the test setup must be connected and detected by the application, before running the test.

To refresh the list of connected instruments:

1. Select Options > Instrument Control Settings.
2. In the Search Criteria section of the Instrument Control Settings dialog box, select the connection types of the instruments to

search. Instrument search is based on the VISA layer, but different connections determine the resource type, such as LAN, GPIB, and
USB. For example, if you choose LAN, the search will include all the instruments supported by the TekExpress that are communicating
over the LAN.

3. Click Refresh. The TekExpress application searches for the connected instruments.

Search status of the instruments connected to LAN

Setting up the test environment

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 22



4. When the search is complete, a dialog box lists the instrument-related details based on the search criteria. For example, for the Search
Criteria as GPIB, the application displays all the GPIB instruments connected to the application.

TekExpress Instrument Control Settings window.

The details of the instruments are displayed in the Retrieved Instruments table. The time and date of instrument refresh is displayed in
the Last Updated field.

Running tests
After selecting and configuring tests, review the pre-run checklist and then click Start to perform the tests. The application acquires and
analyzes the data, then displays a report when the tests are finished.

While the tests are running, other applications may display windows in the background. The TekScope application takes precedence over
other applications, but you can switch to other applications by using the Alt+Tab key combination. To keep the TekExpress SFP+ QSFP+
Tx application on top, select Keep On Top from the SFP+ QSFP+ Tx Options menu.

Before you click start
Before you run tests for the first time, do the following:

1. Understand where your test files are stored on the instrument.

After you install and launch TekExpress SFP+ QSFP+ Tx, it creates the following folders on the oscilloscope:

• \My Documents\My TekExpress\SFP+ QSFP+ Tx
• \My Documents\My TekExpress\SFP+ QSFP+ Tx\Untitled Session
Every time you launch TekExpress SFP+ QSFP+ Tx, an Untitled Session folder is created in the SFP-Tx folder. The
Untitled Session folder is automatically deleted when you exit the SFP+ QSFP+ Tx application. To preserve your test
session files, save the test setup before exiting the TekExpress application.

CAUTION: Do not modify any of the session files or folders because this may result in loss of data or corrupted session files.
Each session has multiple files associated with it. When you save a session, a .TekX file, and a folder named for the session
that contains associated files, is created on the oscilloscope X: drive.

2. Map the shared My TekExpress folder as X: (X drive) on the instruments used in test setups running Microsoft Windows Operating
System.

Setting up the test environment
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The My TekExpress folder has the share name format <domain><user ID>My TekExpress. Or, if the instrument is not
connected to a domain, the share name format is <instrument name><user ID>My TekExpress. This shared folder
is used to save the waveform files and is used during other file transfer operations.

Note: If the X: drive is mapped to any other shared folder, the application will display a warning message asking you to
disconnect the X: drive manually.

3. Make sure that the My TekExpress folder has read and write access, and that the contents are not set to be encrypted:

a. Right-click the folder and select Properties.
b. Select the General tab and then click Advanced.
c. In the Advanced Attributes dialog box, make sure that the option Encrypt contents to secure data is NOT selected. Example.

4. See the pre-run checklist before you run a test.

Pre-run checklist
Do the following before you click Start to run a test. If this is the first time you are running a test on a setup, refer to the information in
Before you click start.

1. Make sure that all the required instruments are properly warmed up (approximately 20 minutes).
2. Perform Signal Path Compensation (SPC).

a. On the oscilloscope main menu, select the Utilities menu.
b. Select Instrument Calibration.

3. Deskew channels.
4. Verify that the application is able to find the DUT. If it cannot, perform a search for connected instruments.

a. In SFP+ QSFP+ Tx, select the Setup panel and then click the Test Selection tab.
b. Select any test and then click Configure.
c. In the Configuration section, click Global Settings.

Setting up the test environment
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d. In the instruments detected section, click the drop-down arrow to the right of real time scope and make sure that the oscilloscope
with the (GPIB8::1::INSTR) designation is in the list.

Setting up the test environment
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Starting the application
To start the TekExpress SFP+ QSFP+, select from the oscilloscope menu bar Applications > TekExpress SFP+ QSFP+.

During start, a "My TekExpress" folder is created in the Documents folder of the current user and gets mapped to "X" drive. When the
application is closed properly, the "X" drive gets unmapped. Session files are then stored inside the X:\SFP+ QSFP+ folder. If this
file is not found, the application runs an instrument discovery program to detect connected instruments before starting TekExpress SFP+
QSFP+.

To keep the TekExpress SFP+ QSFP+ application on top of any application, select Keep On Top from the options menu. If the application
goes behind the oscilloscope application, select Applications >TekExpress SFP+ QSFP+ to bring the application to the front.

Starting the application
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Application controls
This section describes the application controls with functionality and its details.

Table 5: Application control description

Item Description
Options menu Menu to display global application controls.

Test panel Controls that open tabs for configuring test settings and options.

Start / Stop button Use the Start button to start the test run of the measurements in the selected order. If prior
acquired measurements are not cleared, then new measurements are added to the existing
set. The button toggles to the Stop mode while tests are running. Use the Stop button to
abort the test.

Pause / Continue button Use the Pause button to pause the acquisition. When a test is paused, this button changes
as Continue.

Clear button Use the Clear button to clear all existing measurement results. Adding or deleting a
measurement, or changing a configuration parameter of an existing measurement, also
clears measurements. This is to prevent the accumulation of measurement statistics or
sets of statistics that are not coherent. This button is available only on Results panel.

Note: This button is visible only when there are results data on the panel.

Application window move icon Place the cursor over the top of the application window to move the application window to
the desired location

Minimize icon Minimizes the application.

Close icon Close the application.

Table continued…

Starting the application
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Item Description
Mini view / Normal view Mini view displays the run messages with the time stamp, progress bar, Start / Stop button,

and Pause / Continue button. The application moves to mini view when you click the Start
button.

Options menu functions
To access the Options menu, click  in the upper-right corner of the application. It has the following selections:

Table 6: Options menu settings

Menu Function
Default Test Setup Opens a new test setup with default configurations.
Open Test Setup Opens a previously saved test setup. Displays the list of previously saved test setup file

names. Make the selection and click OK to open the test setup.
Save Test Setup Saves the current test configurations with the specified file name.
Save Test Setup As Saves the current test setup with a different file name or file type.
Open Recent Displays the recently opened test setup file names. Make the selection and click OK to

open the test setup.
Instrument Control Settings Detects, lists, and refreshes the connected instruments found on the specified connections

(LAN, GPIB, USB, Serial, Non-VISA Resources, TekLink, and VXI).

Keep On Top Always keeps the TekExpress SFP+ QSFP+ application on top of all the applications.

Email Settings Configures email options for test run and result notifications.
Deskew Loads oscilloscope channel deskew settings into the application.
Help Displays the TekExpress SFP+ QSFP+ help.
Table continued…

Starting the application
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Menu Function
About TekExpress Displays the application name, version, and hyperlink to end the user license agreement.

Starting the application
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Configure email settings
Use the Email Settings utility to get notified by email when a measurement completes or produces any error condition. Follow the steps to
configure email settings: 

Figure 1: Email settings window

1. Select Options > Email Settings to open the Email Settings dialog box.
2. (Required) For Recipient email Address(es), enter one or more recipient email addresses. To include multiple addresses, separate

the addresses with commas.
3. (Required) For Sender’s Address, enter the email address used by the instrument. This address consists of the instrument name,

followed by an underscore, followed by the instrument serial number, then the @ symbol, and the email server ID. For example:
user@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server address of the Mail server configured at the client location,
and the SMTP Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name, password, and host name in the corresponding fields.

Note: If any of the above required fields are left blank, the settings will not be saved, and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:

• Reports: Select to receive the test report with the notification email.
• Status Log: Select to receive the test status log with the notification email. If you select this option, then also select whether you

want to receive the full log or just the last 20 lines.
6. In the Email Configuration section:

• Enter a maximum file size for the email message. Messages with attachments larger than this limit will not be sent. The default is
5 MB.

• Enter the number in the Number of Attempts to Send field, to limit the number of attempts that the system makes to send a
notification. The default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use this check box to quickly enable or disable email
notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.

Starting the application
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TekExpress instrument control settings
Use the TekExpress Instrument Control Settings dialog box to search the instruments (resources) connected to the application. You
can use the Search Criteria options to search the connected instruments depending on the connection type. The details of the connected
instrument is displayed in the Retrieved Instruments window.

To access, click Options > Instrument Control Settings. Select GPIB as search criteria for TekExpress application and click Refresh.
The connected instruments displayed in the Retrieved Instruments window and can be selected for use under Global Settings in the test
configuration section. 
Figure 2: TekExpress Instrument Control Settings window

See also
Options menu functions on page 28

Starting the application
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Setup panel: Configure the test setup
The Setup panel contains sequentially ordered tabs that help you guide through the test setup and execution process.

Figure 3: DUT tab, QSFP+ Tx compliance view

Setup panel: Configure the test setup
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Figure 4: DUT tab, QSFP+ Tx advanced view

Figure 5: DUT tab, SFP+ Tx compliance view

Setup panel: Configure the test setup
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DUT: Set DUT settings
Use the DUT tab to select parameters for the device under test. These settings are global and apply to all tests of current session. DUT
settings also affect the list of available tests in the Test Selection tab.

Figure 6: DUT tab

Click Setup > DUT to access the DUT parameters:

Table 7: DUT tab configuration

Setting Description
DUT ID Adds an optional text label for the DUT to reports. The default value is DUT001. The maximum

number of characters supported is 32. You cannot use the characters (.,..,...,\,/:?”<>|*) in an ID
name.

 Comments icon (to the right of the
DUT ID field)

Opens a comments dialog box which allows you to enter optional text to add to a report.
You can enter a maximum number of 256 characters. Refer Select report generation
options on page 47 to enable or disable comments which displays on the test report.

Acquire live waveforms Acquire active signals from the DUT for measurement and analysis.
Use prerecorded waveform files Run tests on a saved waveform. Also refer Load a saved test setup.
View Select the View type from the drop-down:

• Compliance
• Advanced

Note: If you select Advanced View, the configuration settings are included in the Setup
steps. If you select Compliance View, the configuration step is not included as a

Table continued…

Setup panel: Configure the test setup
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Setting Description

separate step. Access configuration parameters for selected tests from the Configure
button in the Test Selection tab.

Standard Select the mode from the drop-down:

• SFP+ Tx
• QSFP+ Tx

Version Displays the version of testing specification
Host Select this option to enable Host tests listed in the Test Selection tab. To include measurements

related to an attached copper cable, select the 10GSFP+Cu Direct Attach Cable check box.

Note: The Host device profile is enabled by default.

Module Select this option to enable Module tests listed in the Test Selection tab.
Number of Lanes to Test Select the Number of Lanes to Test from the drop-down

• 1 Lane
• 2 Lanes
• 4 Lanes

Selected Test Lanes Click the Selected Test Lanes Setup button to open the Test Lane Setup dialog. Use the dialog
to configure which lanes to test.

Setup panel: Configure the test setup
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Test Selection: Select the tests
Use the Test Selection tab to select the tests. The test measurements available depends on the settings selected in the DUT tab. 

Figure 7: Test selection tab

Table 8: Test Selection tab configuration

Setting Description
Deselect All, Select All Deselect or select all tests in the list.
Select Required Selects all test required to pass compliance.
Schematic Displays equipment connection setup for the selected measurements. You need to select at

least a measurement before you click the Schematic.
Configure When the View type selected in the DUT tab is Compliance, this button opens the configuration

section for the selected test. If the View type is Advanced, this button is not displayed.
Test selection field Lists available test and if they are selected to run. Click in the box adjacent to a test to select or

unselect a test.
Test Description Shows a description of the selected test.

Setup panel: Configure the test setup
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Acquisitions: Set waveform acquisition settings
Use Acquisitions tab to view the test acquisition parameters. The contents displayed on this tab depends on the DUT type and the tests
selected.

Figure 8: Acquisition tab

Table 9: Acquisitions tab configuration

Setting Description
Data Source (+), Data Source (–) Sets the channels used for positive and negative data sources. When QSFP+

Tx is the selected standard, data sources for each lane to be tested can be
configured.

Deskew Provides the option of setting deskew values on the scope either in an automated
way or manual way.

Test Name Displays the name of the selected test to which the acquisitions apply. One or
more tests can perform the same acquisitions.

Acquisition The acquisition of the waveform for the corresponding test
Signal Type Shows the acquisition parameters of the signal. This column is displayed only if

the Show Acquire Parameters check box is selected in the Acquisition and Save
Options section.

Waveform File Lists the name of the waveform files used for the test. Select waveform files
by clicking the button in the row and selecting any waveform file using the
standard File Open window. This option is available only when Use pre-recorded
waveform files is selected in the Setup panel DUT tab.

Acquisition and Save Options All waveforms are saved before analysis.
Table continued…
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Setting Description
Show Acquire Parameters When selected, the signal acquisition parameter for each test displays in the

Signal Type column.
Signal Validation Determines how the application responds to the source signal

Note: Signal validation is valid only for Live acquisitions

Prompt me if signal fails If the signal fails, pauses the measurement operation and displays a dialog box
with the following options:

• Reacquire: Try acquiring the signal again.
• Use Anyway: Use the signal even if it cannot be validated.
• Skip Test: Abort the test if the signal cannot be validated.

Use signal as is - Don’t Check Skips the signal validation process. Does not test the signal for its characteristics
Skip test if signal fails Moves to the next test (if applicable) if the signal fails

TekExpress SFP+ QSFP+ application saves all acquisition waveforms to files by default. Waveforms are saved in a unique folder for each
session (a session is started when you click the Start button). The folder path is X:\TekExpress SFP+ QSFP+\Untitled
Session\<dutid>\<date>_<time>. Images created for each analysis, XML files with result values, reports, and other
information specific to that particular execution are also saved in this folder.

Saving a session moves the session file contents from the Untitled Session folder to the specified folder name and changes the session
name to the specified name.

Setup panel: Configure the test setup
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Configuration: Set measurement limits for tests
Use Configuration tab to view and configure the Global Settings and the measurement configurations. The measurement specific
configurations available in this tab depends on the selections made in the DUT panel and Test Selection panel.

Note: The Use Filter File for De-embedding (only for TWDPC) check box is available only if the test Host Output TWDPC is
selected in the Test Selection tab.

Note: If you change the channel selection for Data+ (DP) and Data– (DN) signals, make sure that you change the corresponding
trigger source in the Analyze tab for each of the measurements. If you do not do this, the waveform might not trigger and the
measurements might not be completed.

Table 10: Configuration tab: Common parameters

Settings Description
Limit Editor Displays the upper and lower limits for the applicable measurement using different types of comparisons.

Figure 9: Configuration tab: Global Settings

Setup panel: Configure the test setup
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Table 11: Configuration tab: Global Settings configuration

Setting Description
Compliance Mode Select to use Compliance Mode values. You cannot change

most test parameters in Compliance mode but you can view the
parameters.

User Defined Mode Select to run tests with custom parameters.
Instruments Detected Displays the instruments connected to this application. Click on the

instrument name to open a list of available (detected) instruments.
Select Options > Instrument Control Settings to refresh the
connected instrument list refer TekExpress instrument control
settings.

Record Length Specifies the length of the record (5M is the default)
Data Rate Select the signal data rate as one of 9.95328 Gbps, 10.3125 Gbps

(default), 10.51875 Gbps, or 11.10 Gbps.
Use Filter File for De-embedding (All Test except TWDPC) When selected, provides a browse button and field for selecting a

filter to use to compensate for cable lengths.
Use Filter File for De-embedding for TWDPC When selected, provides a browse button and field for selecting a

filter to use to compensate for cable lengths.

Figure 10: Configuration tab: Measurement

Table 12: Configuration tab: Measurements configuration

Setting Description
Measurements
Table continued…
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Setting Description
Acquire

Signal Type Specifies the signal type of the acquisition for the test selected in the tree view of the
Measurements tab. Running tests in User Defined Mode allows you to perform the tests on
different types of signal. The default signal type varies by test. Not all tests support all the
signal types. For each test, the application includes the signal type options that are best
suited to the measurements.

Window Size (%) Host test Transmitter Qsq only. Set at 10% for Compliance Mode. In User Defined Mode,
you can change this to 5% or 20%.

Setup panel: Configure the test setup
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Preferences: Set the test run preferences
Use Preferences tab to set the application action on completion of a measurement. The Preferences tab has the feature to enable or
disable certain options related to the measurement execution.

Figure 11: Preferences tab

Refer the below table for the options available in the Preferences tab:

Table 13: Preferences tab settings

Setting Description
On Test Failure, stop and notify me of the failure Select to stop the test run on Test Failure, and to get notified via

email. By default, it is unselected. Click Email Settings to configure
the email settings to receive notifications.

Setup panel: Configure the test setup
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Status panel: View the test execution status
The Status panel contains the Test Status and Log View tabs, which provides status on the test acquisition and analysis (Test Status) and
listing of test tasks performed (Log View tab). The application opens the Test Status tab when you start to execute the test. Select the
Test Status or the Log View tab to view these items while the test execution is in progress.

View test execution status
The tests are grouped and displayed based on the Clock and Data lane. It displays the tests along with the acquisition type, acquire, and
analysis status of the tests. In pre-recorded mode, Acquire Status is not valid.

The Test Status tab presents a collapsible table with information about each test as it is running. Use the symbols to expand ( ) and
collapse ( ) the table rows.

Figure 12: Test execution status view in Status panel

Table 14: Test execution status table headers

Table Header Description
Test Name Displays the measurement name.
Acquisition Describes the type of data being acquired.
Acquire Status Displays the progress state of the acquisition:

• To be started
• Completed Acquisition
• Prerecorded waveform

Table continued…

Status panel: View the test execution status
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Table Header Description
Analysis Status Displays the progress state of the analysis:

• To be started
• In progress
• Completed
• Aborted

View test execution logs
The Test Status tab displays the detailed execution status of the tests. Also, displays each and every execution step in detail with its
timestamp information. The log details can be used to troubleshoot and resolve any issue/bug which is blocking the test execution process.

Figure 13: Log view in Status panel

Table 15: Status panel settings

Control Description
Message History Lists all the executed test operations and timestamp information.
Auto Scroll Enables automatic scrolling of the log view as information is added to the log during the test execution.

Clear Log Clears all the messages from the log view.
Save Saves the log file into a text file format. Use the standard Save File window to navigate to and specify

the folder and file name to save the log text.

Show Detailed Log Select the check box to record a detailed history of test execution.

Status panel: View the test execution status
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Results panel: View summary of test results
When a test execution is complete, the application automatically opens the Results panel to display a summary of test results.

In the Results table, each test result occupies a row. By default, results are displayed in summary format with the measurement details
collapsed and with the Pass/Fail column visible.

Figure 14: Results panel with measurement results

Note: Results of Crosstalk measurements, Total Jitter @ J2, and Total Jitter @ J9 are not included in the Overall Test Results
because these measurements are informative only. If any of the Crosstalk tests or Total Jitter @ J2 and Total Jitter @ J9 fails, it
will not cause the overall test results to fail.

Click  icon on each measurement in the row to expand and to display the minimum and maximum parameter values of the
measurement.

Filter the test results
Each column in the result table can be customized and displayed by enabling or disabling any column as per your requirement. You can
change the view in the following ways:

• To remove or restore the Pass/Fail column, select Preferences > Show Pass/Fail.
• To collapse all expanded tests, select Preferences > View Results Summary.
• To expand all the listed tests, select View Results Details from the Preferences menu in the upper right corner.
• To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.
• To view the results grouped by lane or test, select the corresponding item from the Preferences menu.
• To expand the width of a column, place the cursor over the vertical line that separates the column from the column to the right. When

the cursor changes to a double-ended arrow, hold down the mouse button and drag the column to the desired width.
• To clear all test results displayed, click Clear.

Results panel: View summary of test results
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Results panel: View summary of test results
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Reports panel: Configure report generation settings
Click Reports panel to configure the report generation settings and select the test result information to include in the report. You can use
the Reports panel to configure report generation settings, select test content to include in reports, generate the report, view the report,
browse for reports, name and save reports, and select report viewing options.

Select report generation options
This section describes the report generation settings you can configure in the Reports panel. Select report settings before running a test or
when creating and saving test setups. Report settings configured are included in saved test setups.

Figure 15: Reports panel

Report Update Mode Settings
Table 16: Report Update Mode Settings

Control Description
Report Generation
Generate new report Each time when you click Run and when the test execution is complete, it will create a

new report. The report can be in either .mht, .pdf, or .csv file formats.
Append with previous run session Appends the latest test results to the end of the current test results report. Each time

when you click this option and run the tests, it will run the previously failed tests and
replace the failed test result with the new pass test result in the same report.

Replace current test in previous run session Replaces the previous test results with the latest test results. Results from newly added
tests are appended to the end of the report.

Table continued…

Reports panel: Configure report generation settings
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Control Description
Report name Displays the name and path of the TekExpress SFP+ QSFP+ report. The default location

is at \My Documents>\My TekExpress\SFP+ QSFP+\Reports. The
report file in this folder gets overwritten each time you run a test unless you specify a
unique name or select to auto increment the report name.

To change the report name or location, do one of the following:

• In the Report Path field, type the current folder path and name.
• Double-click in the Report Path field and then make selections from the popup

keyboard and click Enter.

Be sure to include the entire folder path, the file name, and the file extension.
For example: C:\Documents and Settings\your user name\My
Documents\My TekExpress\SFP+ QSFP+\DUT001.mht.

Note: You cannot set the file location using the Browse button.

Open an existing report

Click Browse, locate and select the report file and then click View at the bottom of the
panel.

Save as type Saves a report in the specified file type, selected from the drop-down list. The report is
saved in .csv, .pdf, or .mht.

Note: If you select a file type different from the default, be sure to change the
report file name extension in the Report Name field to match.

Auto increment report name if duplicate Sets the application to automatically increment the name of the report file if the
application finds a file with the same name as the one being generated. For example:
DUT001, DUT002, DUT003. This option is enabled by default.

Contents To Save
Include pass/fail results summary Select to include pass/fail information in the details table of the report.
Include detailed results Select to include detailed results in the report.
Include plot images Select to include the plot images in the report.
Include setup configuration Sets the application to include hardware and software information in the summary box

at the top of the report. Information includes: the oscilloscope model and serial number,
the oscilloscope firmware version, and software versions for applications used in the
measurements.

Include user comments Select to include any comments about the test that you or another user have added in
the DUT tab of the Setup panel. Comments appear in the Comments section, below the
summary box at the beginning of each report.

Group Test Results by
Test Name Select to group the test results based on the test name in the report.
Lane Select to group the test results based on the Lanes in the report
Other settings in report panel
View report after generating Automatically opens the report in a Web browser when the test execution is complete.

This option is selected by default.
Table continued…
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Control Description
View Click to view the most current report.
Generate Report Generates a new report based on the current analysis results.
Save As Specify a name for the report.

Reports panel: Configure report generation settings
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View a generated report
Sample report and its contents

A report shows detailed results and plots, as set in the Reports panel.

Figure 16: Report

Setup Information The summary box at the beginning of the report lists setup configuration information. This information
includes the oscilloscope model and serial number, optical module model and serial number, and software
version numbers of all associated applications.

Test Name Summary Table The test summary table lists all the tests which are executed with its result status.
Measurement The measurement table displays the measurement related details with its parameter value.
User comments If you had selected to include comments in the test report, any comments you added in the DUT tab are

shown at the top of the report.

Reports panel: Configure report generation settings
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Saving and recalling test setup
Overview
You can save the test setup and recall it later for further analysis. Saved setup includes the selected oscilloscope, general parameters,
acquisition parameters, measurement limits, waveforms (if applicable), and other configuration settings. The setup files are saved under
the setup name at X:\TekExpress SFP+ QSFP+

Figure 17: Example of Test Setup File

Use test setups to:

• Recall a saved configuration.
• Run a new session or acquire live waveforms.
• Create a new test setup using an existing one.
• View all the information associated with a saved test, including the log file, the history of the test status as it executed, and the results

summary.
• Run a saved test using saved waveforms.

Note: Images that are shown in this Saving and recalling test setup chapter are for illustration purpose only and it may vary
depending on the TekExpress application.

Save the configured test setup
You can save a test setup before or after running a test. You can create a test setup from already created test setup or using a default
test setup. When you save a setup, all the parameters, measurement limits, waveform files (if applicable), test selections, and other
configuration settings are saved under the setup name. When you select the default test setup, the parameters are set to the application’s
default value.

• Select Options > Save Test Setup to save the opened setup.

Saving and recalling test setup
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• Select Options > Save Test Setup As to save the setup with different name.

Load a saved test setup
To open (load) a saved test setup, do the following:

• Select Options > Open Test Setup.

Saving and recalling test setup
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• From the File Open menu, select the setup file name from the list and click Open.

Note: Parameters that are set for the respective test setup will enable after opening the file.

Perform a test using pre-run session files
Complete the following steps to load a test setup from a pre-run session:

1. Select Options > Open Test Setup.

Saving and recalling test setup
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2. From the File Open menu, select a setup from the list and then click Open.

Note: Parameters that are set for the respective test setup will enable after opening the file.

3. Switch the mode to Use Pre-recorded waveform files in the DUT panel.

Saving and recalling test setup
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4. Select the required waveforms from the selected setup in the Acquisitions tab and click Start.

5. The selected waveform file can be removed/replaced by clicking on the ( ) icon.

Saving and recalling test setup
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6. After successful completion of the test, the waveform report files are stored at X:\<Application Name>\Reports.

7. The overall test result status after completion of the test execution is displayed in the Results Panel.

Saving and recalling test setup
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Save the test setup with a different name
To save a test setup with a different name, follow the steps:

1. Select Options > Save Test Setup As.

2. Enter the new test setup name and click Save.

Run a saved test in prerecorded mode
Use this option to rerun a complete test using just the oscilloscope and the saved test setup files, provided that you selected to save the
captured waveforms when you originally ran the saved test.

Note: When you run a saved test in prerecorded mode and then save it under the same name, the test results are saved in a
new session folder named for the date and time of the session. Any test settings that you changed for the session will be saved
as a new test session file and be paired with a folder of the same name. Example. When you open a test setup that has multiple

Saving and recalling test setup
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sessions and you select a session from the Run session list in the DUT tab, the settings associated with that test session are
restored.

Each test session folder has a matching test session file that stores the individual test settings for that session.

1. Open a saved test setup.
2. In the Setup panel, select the DUT tab and then select Use pre-recorded waveform files.

A Run session drop-down list appears that displays the previous saved sessions for this test.
3. From the Run session list, select the session to run.

Note: If you select a session for which no waveform files were saved, you will receive an error message. Either select another
test session or select waveform files to use. For details, see Step 2 of Select Acquisitions.

4. Click Start.
5. To save the test results, session settings, and related files, save the test setup before selecting another test setup or exiting

TekExpress SFP+ QSFP+ Tx.

Saving and recalling test setup
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SCPI Commands
About SCPI command
You can use the Standard Commands for Programmable Instruments (SCPI) to communicate remotely with the TekExpress application.
Complete the TCPIP socket configuration and the TekVISA configuration in the oscilloscope or in the device where you are executing the
script.

Note: If you are using an external PC to execute the remote interface commands, then install TekVISA in the PC to make the
configurations.

Socket configuration for SCPI commands
This section describes the steps to configure the TCPIP socket configuration in your script execution device and the steps to configure the
TekVISA configuration in the oscilloscope to execute the SCPI commands.

TCPIP socket configuration
1. Click Start > Control Panel > System and Security > Windows Firewall > Advanced settings.

2. In Windows Firewall with Advanced Security menu, select Windows Firewall with Advanced Security on Local Computer >
Inbound Rules and click New Rule…

SCPI Commands
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3. In New Inbound Rule Wizard menu

a. Select Port and click Next.

b. Select TCP as rule apply, enter 5000 for Specific local ports and click Next.
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c. Select Allow the connection and click Next.

d. Select Domain, Private, Public checkbox and click Next.
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e. Enter Name, Description (optional), and click Finish.

4. Check whether the Rule name is displayed in Windows Firewall with Advanced Security menu > Inbound Rules.
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TekVISA configuration
1. Click Start > All Programs > TekVISA > OpenChoice Instrument Manager.

2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on. Select Socket from the drop-down list, enter the IP address of

the TekExpress device in Hostname and type Port as 5000. Click  to configure the IP address with Port.

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application are in the same system, else enter the IP address of the
oscilloscope where the TekExpress application is running.
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3. Click Search to setup the TCPIP connection with the host. Check whether the TCPIP host name is displayed in OpenChoice
Instrument Manager > Instruments.

4. Double-click OpenChoice Talker Listener and enter the Command *IDN? in command entry field and click Query. Check that the
Operation is successful and Talker Listener Readout displays the Command / Data.
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Set or query the device name of application
This command sets or queries the device name of the application.

Syntax
TEKEXP:SELECT DEVICE,"<DeviceName>" (Set)

TEKEXP:SELECT? DEVICE (Query)

Command arguments
Argument Name Argument Type

<DeviceName>

• QSFP+ Tx
• SFP+ Tx

<String>

NA

Returns
<String>

Examples
TEKEXP:SELECT DEVICE,"<DeviceName>" command sets the device name of the application.

TEKEXP:SELECT? DEVICE command returns the selected device name of the application.

Set or query the suite name of the application
This command sets or queries the suite name of the application.
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Syntax
TEKEXP:SELECT SUITE,"<SuiteName>" (Set)

TEKEXP:SELECT? SUITE (Query)

Command arguments
Argument Name Argument Type and value Description

<SuiteName>

• Host
• Module

<String>

NA

It is the name of the suite on the DUT panel
of the application.

Returns
<String>

Examples
TEKEXP:SELECT SUITE,"<SuiteName>" command sets the suite name of the application.

TEKEXP:SELECT? SUITE command returns the selected suite of the application.

Set or query the test name of the application
This command selects or deselects the specified test name of the application.

Syntax
TEKEXP:SELECT TEST,"<TestName>",<Value> (Set)

TEKEXP:SELECT TEST,"<ALL>" (Set)

TEKEXP:SELECT? TEST (Query)
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Command arguments
Test Name Value
Host

• Single Ended Output Voltage Range
• Output AC Common Mode voltage (RMS)
• Crosstalk Source Rise/Fall Time (20%-80%)
• Crosstalk Source Amplitude (p-p Differential)
• Signal Rise/Fall Time (20%-80%)
• Total Jitter
• Total Jitter @ J2 (Informative)
• Total Jitter @ J9 (Informative)
• Data Dependent Jitter
• Data Dependent Pulse Width Shrinkage
• Uncorrelated Jitter
• Transmitter Qsq
• Eye Mask Hit Ratio
• Voltage Modulation Amplitude (p-p)
• Transmitter Qsq (for Cu)
• Output AC Common Mode voltage (RMS) (for Cu)
• Host Output TWDPc

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

True or 1 - Selected

False or 0 - Unselected

Module

• Single Ended Input Voltage Tolerance
• AC Common Mode Voltage Tolerance
• Crosstalk Source Rise/Fall Time (20%-80%)
• Crosstalk Source Amplitude (p-p Differential)
• Total Jitter
• Total Jitter @ J2 (Informative)
• Total Jitter @ J9 (Informative)
• Data Dependent Jitter
• Data Dependent Pulse Width Shrinkage
• Uncorrelated Jitter
• Eye Mask Hit Ratio
• Output AC Common Mode voltage (RMS)

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

True or 1 - Selected

False or 0 - Unselected

Returns
{True | False} or {1 | 0}

Examples
TEKEXP:SELECT TEST,"<TestName>",1 command selects the specified test in the Test Panel.

TEKEXP:SELECT TEST,"<ALL>" command select all the tests in the Test Panel.

TEKEXP:SELECT? TEST command returns the list of selected tests.
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Set or query the version name of the application
This command sets or queries the version name of the application.

Syntax
TEKEXP:SELECT VERSION,”<VersionName>” (Set)

TEKEXP:SELECT? VERSION (Query)

Command arguments
Argument Name Argument Type Valid Values
<VersionName>

• SFF-8635 Revision 0.4

<String>

• NA

It is the name of the version on the DUT
panel of the application.

Returns
<String>

Examples
TEKEXP:SELECT VERSION,”<VersionName>” command sets the version name of application.

TEKEXP:SELECT? VERSION command returns the version name of application.

Set or query the general parameter values
This command sets or queries the general parameter values of the application.

Syntax
TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" (Set)

TEKEXP:VALUE? GENERAL,"<ParameterName>" (Query)

Command arguments
Table 17: Command arguments for general settings

Parameter Name Value
Direct Attached Cable Cu • Enabled

• Disabled

Device Type • QSFP+ Tx
• SFP+ Tx

Suite Type • Host
• Module

Table continued…
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Parameter Name Value
Record Length • 9.95328

• 10.3125
• 10.51875
• 11.10

Apply Filter • Yes
• No

Filter File Path (.flt file) Filter path (User filter file path)
Apply Filter for TWDPc • Yes

• No

Filter File Path for TWDPc (.flt file) Filter path (User filter file path)

Returns
<NRf> or <String>

Examples
TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" command set the value for the specified general
parameter.

TEKEXP:VALUE? GENERAL,"<ParameterName>" command returns the value for the specified general parameter.
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Set or query the acquire parameter values
This command sets or queries the acquire parameter values of the application.

Syntax
TEKEXP:VALUE
ACQUIRE,”<TestName>",”<AcquireType>”,”<ParameterName>","<ParameterValue>" (Set)

TEKEXP:VALUE? ACQUIRE,”<TestName>",”<AcquireType>”,”<ParameterName>" (Query)

Command arguments
Test Name Acquire Type Parameter Name Parameter Values
Host
Single Ended Output Voltage Range Single Ended Output Voltage Range

Acquisition
Signal Type • Single Ended PRBS7

• Single Ended PRBS9
• Single Ended PRBS11
• Single Ended PRBS15
• Single Ended PRBS20
• Single Ended PRBS23
• Single Ended PRBS31

Output AC Common Mode voltage
(RMS)

Output AC Common Mode voltage
(RMS) Acquisition

• PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Crosstalk Source Rise/Fall Time
(20%-80%)

Crosstalk Source Rise/Fall Time
(20%-80%) Acquisition

• Crosstalk 8180
• Crosstalk PRBS7
• Crosstalk PRBS9
• Crosstalk PRBS11
• Crosstalk PRBS15
• Crosstalk PRBS20
• Crosstalk PRBS23

Crosstalk Source Amplitude (p-p
Differential)

Crosstalk Source Amplitude (p-p
Differential) Acquisition

Signal Rise/Fall Time (20%-80%) Signal Rise/Fall Time (20%-80%)
Acquisition

• 8180
• PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23

Table continued…
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Test Name Acquire Type Parameter Name Parameter Values

• PRBS31

Total Jitter Total Jitter Acquisition Signal Type • PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

BER Range(2-18)
Total Jitter @ J2 (Informative) Total Jitter @ J2 (Informative)

Acquisition
Signal Type • PRBS7

• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Total Jitter @ J9 (Informative) Total Jitter @ J9 (Informative)
Acquisition

Data Dependent Jitter Data Dependent Jitter Acquisition

Data Dependent Pulse Width Shrinkage Data Dependent Pulse Width Shrinkage
Acquisition

• PRBS7
• PRBS9
• PRBS11
• PRBS15

Uncorrelated Jitter Uncorrelated Jitter Acquisition • PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Transmitter Qsq Transmitter Qsq Acquisition • 8180
• PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Eye Mask Hit Ratio Eye Mask Hit Ratio Acquisition • PRBS7

Table continued…
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Test Name Acquire Type Parameter Name Parameter Values

• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Voltage Modulation Amplitude (p-p) Voltage Modulation Amplitude (p-p)
Acquisition

• 8180
• PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Transmitter Qsq (for Cu) Transmitter Qsq (for Cu) Acquisition

Output AC Common Mode voltage
(RMS) (for Cu)

Output AC Common Mode voltage
(RMS) (for Cu) Acquisition

• PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Host Output TWDPc Host Output TWDPc Acquisition

Test Type Acquire Type Parameter Name Parameter Values
Module
Single Ended Input Voltage Tolerance Single Ended Input Voltage Tolerance

Acquisition
Signal Type • Single Ended PRBS7

• Single Ended PRBS9
• Single Ended PRBS11
• Single Ended PRBS15
• Single Ended PRBS20
• Single Ended PRBS23
• Single Ended PRBS31

AC Common Mode Voltage Tolerance AC Common Mode Voltage Tolerance
Acquisition

• PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20

Table continued…

SCPI Commands

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 72



Test Type Acquire Type Parameter Name Parameter Values

• PRBS23
• PRBS31

Crosstalk Source Rise/Fall Time
(20%-80%)

Crosstalk Source Rise/Fall Time
(20%-80%) Acquisition

• Crosstalk 8180
• Crosstalk PRBS7
• Crosstalk PRBS9
• Crosstalk PRBS11
• Crosstalk PRBS15
• Crosstalk PRBS20
• Crosstalk PRBS23

Crosstalk Source Amplitude (p-p
Differential)

Crosstalk Source Amplitude (p-p
Differential) Acquisition

Total Jitter Total Jitter Acquisition Signal Type • PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

BER Range(2-18)
Total Jitter @ J2 (Informative) Total Jitter @ J2 (Informative)

Acquisition
Signal Type • PRBS7

• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Total Jitter @ J9 (Informative) Total Jitter @ J9 (Informative)
Acquisition

Data Dependent Jitter Data Dependent Jitter Acquisition

Data Dependent Pulse Width Shrinkage Data Dependent Pulse Width Shrinkage
Acquisition

• PRBS7
• PRBS9
• PRBS11
• PRBS15

Uncorrelated Jitter Uncorrelated Jitter Acquisition • PRBS7
• PRBS9
• PRBS11
• PRBS15
• PRBS20
• PRBS23
• PRBS31

Eye Mask Hit Ratio Eye Mask Hit Ratio Acquisition
Output AC Common Mode voltage
(RMS)

Output AC Common Mode voltage
(RMS) Acquisition
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Returns
<Nrf>

Examples
TEKEXP:VALUE
ACQUIRE,”<TestName>",”<AcquireType>”,"<ParameterName>","<ParameterValue>" command sets
the value for the specified test and its acquire parameter.

TEKEXP:VALUE? ACQUIRE,”<TestName>",”<AcquireType>”,"<ParameterName>" command returns the
value for the specified test and its acquire parameter.

Set or query the analyze parameter values
This command sets or queries the analyze parameter values of the application.

Syntax
TEKEXP:VALUE ANALYZE,”<TestName>","<ParameterName>","<ParameterValue>" (Set)

TEKEXP:VALUE? ANALYZE,”<TestName>","<ParameterName>" (Query)

Command arguments
Test Name Parameter Name Values
Transmitter Qsq Window Width (%) • 5

• 10
• 20

Transmitter Qsq (for Cu)

Returns
<Nrf>

Examples
TEKEXP:VALUE ANALYZE,”<TestName>","<ParameterName>","<ParameterValue>" command set the
value for the specified test and its analyze parameter.

TEKEXP:VALUE? ANALYZE,”<TestName>","<ParameterName>" command returns the value for the specified test
and its analyze parameter.

Query the available devices in the DUT panel of the application
Syntax
TEKEXP:LIST? DEVICE (Query)

Command arguments
Device Device Type and value Description
<Device> <String>

• QSFP+ Tx
• SFP+ Tx

It is the name of the device on the DUT panel of the application.
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Returns
<String>

Examples
TEKEXP:LIST? DEVICE command returns the list of available devices.

Query the available suites for the selected device
This command queries the list of available suites for the selected device as comma separated values.

Syntax
TEKEXP:LIST? SUITE (Query)

Command arguments
Device and Suite Type Description

QSFP+ Tx

• Host
• Module

SFP+ Tx

• Host
• Module

It is the name of the suites for the selected device.

Returns
<String>

Examples
TEKEXP:LIST? SUITE command returns the list of available suites for the selected device.

Query the list of available tests of the application
This command queries the list of available tests of the application for the selected device as comma separated values.

Syntax
TEKEXP:LIST? TEST (Query)

Command arguments
Test Name String
Host • Single Ended Output Voltage Range

• Output AC Common Mode voltage (RMS)
• Crosstalk Source Rise/Fall Time (20%-80%)
• Crosstalk Source Amplitude (p-p Differential)
• Signal Rise/Fall Time (20%-80%)
• Total Jitter

Table continued…
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Test Name String

• Total Jitter @ J2 (Informative)
• Total Jitter @ J9 (Informative)
• Data Dependent Jitter
• Data Dependent Pulse Width Shrinkage
• Uncorrelated Jitter
• Transmitter Qsq
• Eye Mask Hit Ratio
• Voltage Modulation Amplitude (p-p)
• Transmitter Qsq (for Cu)
• Output AC Common Mode voltage (RMS) (for Cu)
• Host Output TWDPc

Module • Single Ended Input Voltage Tolerance
• AC Common Mode Voltage Tolerance
• Crosstalk Source Rise/Fall Time (20%-80%)
• Crosstalk Source Amplitude (p-p Differential)
• Total Jitter
• Total Jitter @ J2 (Informative)
• Total Jitter @ J9 (Informative)
• Data Dependent Jitter
• Data Dependent Pulse Width Shrinkage
• Uncorrelated Jitter
• Eye Mask Hit Ratio
• Output AC Common Mode voltage (RMS)

Returns
<String>

Examples
TEKEXP:LIST? TEST command returns the list of available tests for the selected device.

Query the available version names of the application
This command queries the list of available version names of the application for the selected device as comma separated values.

Syntax
TEKEXP:LIST? VERSION (Query)

Returns
<String>

Examples
TEKEXP:LIST? VERSION command returns the list of version names for the selected device.
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Query the list of available instruments based on the specified instrument type
This command queries the list of available instruments based on the specified instrument type.

Syntax
TEKEXP:LIST? INSTRUMENT,"<InstrumentType>" (Query)

Command argument
Argument Name Argument value
<InstrumentType> <String>

Returns
<String>

Examples
TEKEXP:LIST? INSTRUMENT,"Real Time Scope" command returns the list of available instruments based on the real
time scope type.

Set or query the IP address of the instrument based on the specified instrument
type
This command sets or queries the IP address of the instrument based on the specified instrument type.

Syntax
TEKEXP:INSTRUMENT? "<InstrumentType>" (Query)

TEKEXP:INSTRUMENT, "<InstrumentType>","<Value>" (Set)

Command argument
Argument Name Argument Type
<InstrumentType> <String>
<Value> <String>

TCPIP::XXX.XX.XXX.XXX::INSTR

Returns
<String>

Examples
TEKEXP:INSTRUMENT? "<InstrumentType>" command returns the IP address of the oscilloscope.

TEKEXP:INSTRUMENT, "<InstrumentType>","<value>" command sets the oscilloscope to the specified IP address.

Query the information of the generated report file
This command queries the information of the generated report file in the format "<FileSize>","<FileName>".
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Pre‐requisite
A session should be run earlier and the report should be generated to get the information of the report.

Syntax
TEKEXP:INFO? REPORT (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? REPORT command returns the information of the generated report in the format ("1215”,"DUT001.mht”).

Query the information of the generated waveform files
This command queries the information of the generated waveform files in the format.

<File1Size,"File1Name”>.

If there are more than one waveform, the waveform file names are displayed with the comma separated values in the format

<File1Size,"File1Name">,<File2Size,"File2Name">.

Syntax
TEKEXP:INFO? WFM (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? WFM command returns the information of the generated waveform in the format (20000858,"X:\SFP+ QSFP+\Untitled
Session\DUT001\20200916_041609\Iter1_Short Record‐length for SCOPE Period_NoSSC_DIFF.wfm”).

Query the information of the generated image files
This command queries the information of the generated image files in the format.

<File1Size,"File1Name”>.

If there are more than one image, the image file names are displayed with the comma separated values in the format

<File1Size,"File1Name">,<File2Size,"File2Name">.

Syntax
TEKEXP:INFO? IMAGE (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>
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Examples
TEKEXP:INFO? IMAGE command returns the information of the generated image in the format (109058, "X:\SFP+ QSFP+
\Untitled Session\DUT001\20200916_041609\Iter1_Short Record‐length for SCOPE Period_NoSSC_DIFF.png";22794,"X:\SFP+ QSFP+
\UntitledSession\DUT001\20 200916_041609\ScopePeriodPlot_Iteration1WithCursor.png").

Query the active TekExpress application name
This command queries the active TekExpress application name running on the oscilloscope.

Syntax
TEKEXP:*IDN? (Query)

Returns
<String>

Examples
TEKEXP:*IDN? command returns the active TekExpress application name running on the oscilloscope.

Set or query the DUTID of application
This command sets or queries the DUTID of the application.

Syntax
TEKEXP:VALUE DUTID,"<Value>" (Set)

TEKEXP:VALUE? DUTID (Query)

Command arguments
Argument Name Argument Type
<Value> <String>

Returns
<String>

Examples
TEKEXP:VALUE DUTID,"DUT001" command sets the DUTID of the application to DUT001.

TEKEXP:VALUE? DUTID command returns the DUTID of the application.

Sets or query the acquire mode status
This command sets or queries the acquire mode status.

Syntax
TEKEXP:ACQUIRE_MODE <Mode> (Set)

TEKEXP:ACQUIRE_MODE? (Query)
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Command arguments
Argument Name Argument value
<Mode> • LIVE

• PRE‐RECORDED

Returns
LIVE | PRE‐RECORDED

Examples
TEKEXP:ACQUIRE_MODE LIVE command sets the acquire mode to the Live mode.

TEKEXP:ACQUIRE_MODE? command returns the current acquire mode.

Set or query the execution mode status
This command sets or queries the execution mode status.

Syntax
TEKEXP:MODE <Mode> (Set)

TEKEXP:MODE? (Query)

Command arguments
Argument Name Argument value
<Mode> • COMPLIANCE

• USER‐DEFINED

Returns
COMPLIANCE | USER‐DEFINED

Examples
TEKEXP:MODE COMPLIANCE command sets the execution mode to the compliance mode.

TEKEXP:MODE? command returns the current execution mode.

Generate the report for the current session
This command generates the report for the current session.

Syntax
TEKEXP:REPORT GENERATE(Set)

Arguments
N/A

Examples
TEKEXP:REPORT GENERATE command generates the report for the current session.
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Query the value of specified report header field in the report
This command queries the value of specified report header field in the report.

Syntax
TEKEXP:REPORT? ”<Device Field>” (Query)

Command arguments
Argument Name Argument Type
<Device Field>

Device field is the header name of each field in the setup
information section of the report.

<String>

Returns
<String>

Examples
TEKEXP:REPORT? "DUT ID" command returns the value of DUT ID field in the report.

Query the value of specified result detail available in report summary/details
table
This command queries the value of specified result detail available in report summary/details table.

Syntax
TEKEXP:RESULT? "<TestName>" (Query)

TEKEXP:RESULT? "<TestName>","<ColumnName>" (Query)

TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber> (Query)

Command arguments
Argument Name Argument Type
<TestName>

It is the test name of which the details are required in the report.

<String>

<ColumnName>

It is the column header name of which the details are required in the
report.

<String>

<RowNumber>

It is the row number of which the details are required in the report.

<String>
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Returns
<String>

Examples
TEKEXP:RESULT? "<TestName>" will return the pass fail status of test.

TEKEXP:RESULT? "<TestName>","<ColumnName>" will return all the row values of specific column for the test with
comma separated values.

TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber> will return the column value of specified row
number.

Restore the setup to default settings
This command restores the setup to default settings.

Syntax
TEKEXP:SETUP Default(Set)

Arguments
N/A

Examples
TEKEXP:SETUP Default command restores the setup to default settings.

Save the setup
This command saves the setup.

Syntax
TEKEXP:SETUP Save(Set)

Examples
TEKEXP:SETUP Save command saves the setup.

Save the settings to a specified session
This command saves the settings to a specified session.

Syntax
TEKEXP:SETUP Save,"<SessionName>"
Command arguments
Argument Name Argument value
<SessionName> <String>

Examples
TEKEXP:SETUP Save,"<SessionName>" command saves the settings to a specified session.
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Open the setup from a specified session
This command opens the setup from a specified session.

Syntax
TEKEXP:SETUP Open,"<SessionName>"(Set)

Command arguments
Argument Name Argument value
<SessionName> <String>

Examples
TEKEXP:SETUP Open,"<SessionName>" command opens the setup from a specified session.

Query the current setup file name
This command queries the current setup file name.

Syntax
TEKEXP:SETUP? CURRENT (Query)

Returns
<String>

Examples
TEKEXP:SETUP? CURRENT command returns the current setup file name.

Run/stop/pause/resume the selected measurements execution in the application
This command run/stop/pause/resume the selected measurements execution in the application.

Syntax
TEKEXP:STATE <operation mode> (Set)

Command arguments
Argument Name Argument value
<operation mode> • RUN

• STOP
• PAUSE
• RESUME

Returns
RUN | STOP | PAUSE | RESUME

Examples
TEKEXP:STATE RUN command runs the execution for the selected measurements.
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Query the current measurement execution status
This command queries the current measurement execution status.

Syntax
TEKEXP:STATE? (Query)

Returns
RUNNING | PAUSED | WAIT | ERROR | READY

Examples
TEKEXP:STATE? command returns the current measurement execution status.

Query whether the current setup is saved or not saved
This command queries whether the current setup is saved or not saved.

Syntax
TEKEXP:STATE? SETUP (Query)

Returns
Saved or Not‐Saved

Examples
TEKEXP:STATE? SETUP command returns whether the current setup is saved or not saved.

Exit or close the application
The command exits or close the application

Syntax
TEKEXP:EXIT(Set)

Examples
TEKEXP:EXIT command close the application.

Query the status of the previous command execution
This command queries whether the previous command execution is completed successfully.

Syntax
TEKEXP:*OPC? (Query)

Returns
{0 | 1} or {True | False}

1 or True indicates that command execution is successful.

0 or False indicates that command execution is failed.
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Examples
TEKEXP:*OPC? command returns whether the previous command operation is completed successfully.

Query the last error occurred
This command queries the last error occurred.

Syntax
TEKEXP:LASTERROR? (Query)

Returns
<String>

Examples
TEKEXP:LASTERROR? command returns the last error occurred.

Set or query the popup details
This command sets or queries the popup details.

Syntax
TEKEXP:POPUP? (Query)

TEKEXP:POPUP "<PopupResponse>" (Set)

Command arguments
Argument Name Argument value
<PopupResponse> • Yes

• No

Returns
The pop‐up details return in the following format:

"<Tittle>","<message>","<response1>,<response2>".

Where,

<Tittle> :: <String>

<message> :: <String>

<response1>,<response2> :: <String>

Examples
TEKEXP:POPUP? command returns the popup details in following format ": "Do you really want to exit TekExpress?";Responses: "Yes,
No".

TEKEXP:POPUP "Yes" command sets the popup response to Yes.

Sets or query the limit values in the limits editor window
This command sets or queries the limit values in the limits editor window.
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Syntax
TEKEXP:VALUE LIMIT,<TestName>,<LimitHeader>,<Value1>,<CompareString>,<Value2>(Set)

TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> (Query)

Returns
<String> or <NRf>

Examples
TEKEXP:VALUE LIMIT,<TestName>,<LimitHeader>,<Value1>,<CompareString>,<Value2> command
sets the limits value for the specified testname and limit header.

TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> command returns the limits value for the specified testname and
limit header.

Set or query the waveform file recalled for the specified test name and acquire
type
This command set or queries the waveform file recalled for the specified test name and acquire type.

If there are more than one waveform, the waveform file names are displayed with the symbol "$" separated values in the format

<WaveformFileName1$ WaveformFileName2>.

Syntax
TEKEXP:VALUE WFMFILE,<TestName>,<AcquireType>,<WaveformFileName> (Set)

TEKEXP:VALUE? WFMFILE,<TestName>,<AquireType> (Query)

Returns
<String>

Examples
TEKEXP:VALUE WFMFILE,<TestName>,<AquireType>,<WaveformFileName> command recalls the sepcified
waveform file for the specified testname and acquire type.

TEKEXP:VALUE? WFMFILE,<TestName>,<AquireType> command returns the waveform file name recalled for the
specified testname and acquire type.

Set or query the enable/disable status of Verbose function
This command sets or queries the enable/disable status of Verbose function.

Syntax
TEKEXP:VALUE VERBOSE,"<Value>" (Set)

TEKEXP:VALUE? VERBOSE (Query)
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Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE VERBOSE,"<Value>" command enable or disable the Verbose function.

TEKEXP:VALUE? VERBOSE command returns the enable or disable status of Verbose function.

Query the enable or disable status of Continuous run function.
This command queries the enable or disable status of Continuous run function.

Syntax
TEKEXP:VALUE? GENERAL,"Enable Continuous Run" (Query)

Returns
{True | False} or {0 | 1}

Where,

1 or True indicates that the continuous run function is enabled.

0 or False indicates that the continuous run function is disabled.

Examples
TEKEXP:VALUE? GENERAL,"Enable Continuous Run" command returns the enable or disable status of continuous run
function.

Set or query the enable/disable status of Continuous Run function
This command sets or queries the enable/disable status of Continuous Run function.

Syntax
TEKEXP:VALUE ContinuousRun,"<Value>" (Set)

TEKEXP:VALUE? ContinuousRun (Query)
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Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE? ContinuousRun command returns the enable or disable status of Continuous run function.

TEKEXP:VALUE ContinuousRun,"<Value>" command enable or disable the Continuous run function.

Set or query the continuous run duration time value
This command sets or queries the continuous run duration time value.

Syntax
TEKEXP:VALUE? ContinuousRun_Duration (Query)

TEKEXP:VALUE ContinuousRun_Duration,"<Value>" (Set)

Arguments
Argument Name Argument value
<Value> Infinite | hh:mm

Infinite sets the radio on button to infinite.

hh:mm sets the continuous run duration to the specified time in
hours and minutes. The minimum time duration you can set is
00:30.

Returns
Infinite | hh:mm

Examples
TEKEXP:VALUE? ContinuousRun_Duration command returns the continuous run duration time value.

TEKEXP:VALUE ContinuousRun_Duration,"<Value>" command sets the continuous run duration time value.

Set or query the session create option in the continuous run function
This command sets or queries the option for session creation in the continuous run function.
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Syntax
TEKEXP:VALUE? ContinuousRun_RunSessionOptions (Query)

TEKEXP:VALUE ContinuousRun_RunSessionOptions,"Value" (Set)

Arguments
Argument Name Argument value
<Value> NewSession | SameSession_ClearResults

NewSession - creates new session for each run.

SameSession_ClearResults - Clears the test results of the current
session and starts the test execution. The session results will be
added in the same session, by erasing the previous run results.

Returns
NewSession | SameSession_ClearResults

Examples
TEKEXP:VALUE? ContinuousRun_RunSessionOptions command returns the option for session creation in the
continuous run function.

TEKEXP:VALUE ContinuousRun_RunSessionOptions,"Value" command sets the option for session creation in the
continuous run function.

Set or query the View report after generating option status
This command sets or queries the enable/disable status of the View report after generating function.

Syntax
TEKEXP:VALUE? GENERAL,"View Report After Generating" (Query)

TEKEXP:VALUE GENERAL,"View Report After Generating",<value> (Set)

Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE? GENERAL,"View Report After Generating" command returns the enable or disable status of
view report after generating option.

SCPI Commands

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 89



TEKEXP:VALUE GENERAL,"View Report After Generating",<value> command enable or disable the view
report after generating option.

Returns the report as XML string
This command returns the report as XML string.

Syntax
TEKEXP:REPORTASXML? (Query)

Returns
<String>

Examples
TEKEXP:REPORTASXML? command returns the report XML string.

Copies all the images from current run session to the given destination location
This command copies all the images from current run session to the given destination location.

Syntax
TEKEXP:COPYIMAGES <DestinationPath> (Set)

Command argument
<DestinationPath> :: <String>

Returns
NA

Examples
TEKEXP:COPYIMAGES C:\Temp command copies all the images from current run session to the mentioned location.

Selects the specified test(s) and deselect all other tests
This command selects the specified test(s) and deselect all other tests.

Syntax
TEKEXP:SELECTID <”TestID”> (Set)

Command argument
Argument Name Argument value
TestID String

Returns
NA

Examples
TEKEXP:SELECTID "11101"This command select the test associated with the ID and deselects all other tests in the application.
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TEKEXP:SELECTID “11101,11102”This command selects the tests associated with the IDs and other tests will be deselected.

Returns the complete information about the selected test
This command returns the complete information about the selected test.

The information includes application name, TestID, Device selected, Suite selected, version, Test name, Test description.

Syntax
TEKEXP:TESTINFO? (Query)

Returns
<String>

Examples
TEKEXP:TESTINFO? This command returns the following details:

<TekExpress> <Test Id="11101" Device="TX-Device" Suite="Group1" Version="Spec 1.0" Name="Algorithm Library Measurement"
Description="This is Algorithm Library measurement test. Refer Section-B of TekExpress SampleApp Development Guide for more details.

Set the default session
Sets the application configurations to default value.

Syntax
TEKEXP:SESSION DEFAULT (set)

Examples
TEKEXP:SESSION DEFAULT, sets the application configurations to default value.

Save the run/config sessions
Enter the name to save/config the session.

Syntax
TEKEXP:SESSION SAVE,“Session Name” (set)

Command arguments
Argument Name Argument value
<Session Name> <String>

Examples
TEKEXP:SESSION SAVE,“Session Name” saves the session.

Load the run/config session
Load the selected config/run session.
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Syntax
TEKEXP:SESSION LOAD, “Session Name” (set)

Command arguments
Argument Name Argument value
<Session Name> <String>

Examples
TEKEXP:SESSION LOAD, “Session Name”, load the selected config/run session.

Delete the run/config session
Deletes the selected config/run session.

Syntax
TEKEXP:SESSION DELETE, "Session1, Session2" (set)

Command arguments
Argument Name Argument value
<Session Name> <String>

Examples
TEKEXP:SESSION DELETE, "Session1, Session2", deletes the selected config/run session.

Run the run/config saved session
Run the selected config/run session.

Syntax
TEKEXP:SESSION RUN, “Session Name’s separated by comma” (set)

Command arguments
Argument Name Argument value
<Session Name> <String>
Session Name’s separated by comma (to run the multiple run
sessions)

<String>

Examples
TEKEXP:SESSION RUN, “Session Name’s separated by comma”, runs the selected config/run session.

Query the available list in the run/config session
Returns the list of available config/run session.
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Syntax
TEKEXP:SESSION? LIST
Returns
Returns the list of available config/run session.

Examples
TEKEXP:SESSION? LIST, returns the list of available config/run session.

Query the current run/config session
Returns the selected config/run session.

Syntax
TEKEXP:SESSION? CURRENT
Returns
Returns the selected config/run session.

Examples
TEKEXP:SESSION? CURRENT, returns the selected config/run session.

Override the run/config session
Overrides the selected config/run session.

Syntax
TEKEXP:SESSION SAVE,"SessionName", "True" (set)

Command arguments
Argument Name Argument Type Argument Value
<Session Name> <String> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:SESSION SAVE,"SessionName", "True", overrides the selected config/run session.
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SFP+ QSFP+ Tx tests

Testing procedures and examples

Signal types used by tests
The following tables list the signal types used by each measurement for the two profiles.

Host profile
Table 18: Host profile measurement signal types

Measurement Compliance mode
support

User-Defined mode support

Single Ended Output Voltage Range PRBS31 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Output AC Common-Mode voltage (RMS)
Crosstalk Source Rise/Fall Time (20%-80%) 8180 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31,

8180Crosstalk Source Amplitude (p-p)
Signal Rise/Fall Time (20%-80%)
Total Jitter PRBS31 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Total Jitter @ J2
Total Jitter @ J9
Data Dependent Jitter PRBS9 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Data Dependent Pulse Width Shrinkage
(DDPWS)

PRBS7, PRBS9, PRBS11, PRBS15

Uncorrelated Jitter PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Transmitter Qsq 8180 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31,

8180
Eye Mask Hit Ratio PRBS31 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Voltage Modulation Amplitude (p-p) 8180 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31,

8180Transmitter Qsq (for Cu)
Output AC Common Mode voltage (RMS)
(for Cu)

PRBS31 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31

Host Output TWDPc PRBS9 PRBS9

Module profile
Table 19: Module profile measurement signal types

Measurement Compliance mode
support

User-Defined mode support

AC Common Mode Voltage Tolerance PRBS31 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Single Ended Input Voltage Tolerance
Table continued…
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Measurement Compliance mode
support

User-Defined mode support

Crosstalk Source Rise/Fall Time (20%-80%) 8180 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31,
8180Crosstalk Source Amplitude (p-p)

Output AC Common-Mode voltage (RMS) PRBS31 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Total Jitter
Total Jitter @ J2
Total Jitter @ J9
Data Dependent Jitter PRBS9 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Data Dependent Pulse Width Shrinkage
(DDPWS)

PRBS7, PRBS9, PRBS11, PRBS15

Uncorrelated Jitter PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31
Eye Mask Hit Ratio PRBS31 PRBS7, PRBS9, PRBS11, PRBS15, PRBS20, PRBS23, PRBS31

Oscilloscope setup
The following tables show the generalized oscilloscope setup parameters for all tests, except where noted.

Table 20: Horizontal setup

Mode Sample Rate Record Length Acquisition Mode
Manual 100 GS/s 5M, 10M 100 GS/s

Table 21: Vertical setup

Channel 1 Channel 2
Position Scale Offset Position Scale Offset
0 Vertical setup

procedure
0 0 Vertical setup

procedure
0

Signal validation procedure
Each measurement goes through signal validation, signal acquisition, and measurement steps. Before running any measurement, check
the signal for validity. To do this, set up the oscilloscope to acquire the signal and then test the signal for its characteristics such as
voltage level and/or frequency. Once the characteristics of the signal are correct, the signal is valid and ready for use in compliance
measurements. The signal validation procedure is the same for both Host and Module Profile measurements.

SFP+ solution supports three types of signals: PRBS9, PRBS31, and 8180.

Note: PRBS20, PRBS23, PRBS31 pattern validation is not done. The signal is assumed to be PRBS20, PRBS23, or PRBS31
respectively.

Acquire the signal according to the SFF-8431 specification. The oscilloscope setup differs for each measurement. For all measurements,
use the following guidelines to set up the oscilloscope. For the oscilloscope setup for individual tests, see the individual test topics.

After the signal is acquired, the measurement is conducted using either the base oscilloscope, DPOJET, or the TekExpress algorithm
library.
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Oscilloscope setup guidelines
The following describes the oscilloscope setup and signal validation measurement for PRBS7, PRBS9, PRBS11, PRBS15, and 8180
signals.

1. Connect the input signal to the appropriate channels. (The channels are those selected as data sources in the Acquisitions tab of the
Setup panel.)

The vertical setup routine runs automatically to find the best fitting vertical scale.

Horizontal setup uses these parameters:

• Mode: Manual
• Sample Rate: 100 GS/s
• Record Length: 5M/10M
• Acquisition Mode: Sample

2. On the oscilloscope, set Math1 = (Ch1 – Ch3).
3. Call the Signal Validation algorithm to verify the signal type.

The signal validation results are returned from the algorithm. If signal validation fails, display a signal validation message.

Host test: SFF-8431 table 11 tests

Single-ended output voltage range
Single-ended output voltage range is measured as the single-ended peak-to-peak output voltage for the positive and negative data
channels on a single acquisition. This test is one of the SFF-8431 Table 11 Output Electrical Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation
Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the PRBS31
pattern is valid.

Measurement procedure
Single-ended output voltage range is measured using base DPOJET.

• Use DPOJET measurement name: Ampl > Max and Ampl > Min for Dp and Dn

Limits
For each of Dp and Dn: Minimum = –0.3 V; Maximum = 4 V

Snapshot and cursor placement details
There will be two snapshots:

• A snapshot of Dp with cursors placed at maximum and minimum voltages of single-ended Pk-Pk measurement value of Dp. Cursor
values can be derived using DPOJET: Ampl > Cycle Max and Ampl > Cycle Min for +ve and –ve peak, respectively for Dp.

• A snapshot of Dn with cursors placed at maximum and minimum voltages of single-ended Pk-PK measurement value of Dn. Cursor
values can be derived using DPOJET: Ampl > Cycle Max and Ampl > Cycle Min for +ve and –ve peak, respectively for Dn.

Output AC Common-Mode voltage (RMS) (Host)
Output AC common-mode voltage is measured as the AC RMS voltage of the common mode ((DP+DN) ÷ 2) signal. This test is one of the
SFF-8431 Table 11 Output Electrical Specifications at B tests.
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Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation
Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the PRBS31
pattern is valid.

Measurement procedure
Output AC common-mode voltage is measured using the base oscilloscope.

1. Math1 = (Dp + Dn) ÷ 2. Switch off channels connected to Dp and Dn.
2. Draw a histogram bounding box from the top left of the oscilloscope to the bottom right, and choose Histogram Vertical.
3. Select Math1 as the histogram source.
4. From the Measure menu, select Histogram Measurements > Standard Deviation.
5. Do a single step run and measure the mean value of the histogram standard deviation. This is the measurement result.

Limits
Maximum = 15 mV

Snapshot and cursor placement details
A snapshot where the histogram on math and the standard deviation value of the histogram is visible on the screen. The standard
deviation value visible on the screen should be the value reported in the report. No cursors are required.

Host test: SFF-8431 table 12 tests

Crosstalk source Rise/Fall time (20% - 80%) (Host)
Crosstalk source rise/fall time is measured as the 20% – 80% (of VMA) Rise time and 80% – 20% (of VMA) Fall time of the differential
Crosstalk Source introduced to the signal. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: Table 12 Crosstalk Source Tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The crosstalk source rise/fall time measurement is performed using the algorithm library.

Inputs to algorithm
• Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying 12 GHz filter
• Signal Type ("SFPPlus.SignalType")

Algorithm
• Input the differential waveform.
• Obtain values of vHigh and vLow as done in the VMA measurement (averaged over all the patterns found in the waveform).
• Find the position of the rising and falling edges in the input waveform.
• On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found (= End) and traverse backward until

the first point crossing the lower limit (20%) is found (= Start).
• On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found (= Start) and traverse forward until

the first point crossing the lower limit (20%) is found (= End).
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• Transition time is computed as TT = (End – Start). This value is averaged across all edges.
• End

Limits
Target value = 34 ps

Snapshot and cursor placement details
This measurement has two snapshots: the first with cursors placed at the rise time, the second with cursors placed at the fall time.

• Rise time: Zoom to the cursor positions. Cursor1 = starting point of RT of first rising edge, cursor2 = ending point of RT of first rising
edge.

• Fall time: Zoom to the cursor positions. Cursor1 = starting point of FT of first falling edge, cursor2 = ending point of FT of first falling
edge

Crosstalk source amplitude (p-p differential) (Host)
Crosstalk source amplitude is measured as the difference between the nominal one and zero levels, which are defined as voltages
measured in the mid 20% of the high (eight 1s) and low (eight 0s) regions respectively, of the differential crosstalk source introduced to the
signal. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: Table 12 Crosstalk Source Tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The crosstalk source amplitude (p-p differential) measurement is performed using the algorithm library.

Inputs to algorithm
Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying 12 GHz filter

Algorithm
• Input the differential waveform.
• On the input waveform, identify the regions with the pattern 11111111 or 00000000.
• On each such pattern, measure the mean voltage in the middle 20% of the pattern.
• The mean voltages corresponding to the Signal High regions is taken as vHigh, and the mean voltages corresponding to the Signal

Low is taken as vLow. The vHigh and vLow values are averaged across all regions.
• The required result Amplitude is given by, Amplitude = vHigh – vLow.
• End

Limits
Target value = 1000 mV

Snapshot and cursor placement details
This measurement has one snapshot with cursor1 = +ve high of VMA, cursor2 = –ve high of VMA.

Signal Rise/Fall time (20% - 80%)
Signal rise/fall time is measured as the 20% – 80% (of VMA) Rise time and 80% – 20% (of VMA) Fall time of the input signal. This test is
one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.
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Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The signal rise/fall time (20% – 80%) measurement is performed using the algorithm library.

Inputs to algorithm
• Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying 12 GHz filter
• Signal Type ("SFPPlus.SignalType")

Algorithm
• Obtain values of vHigh and vLow as done in the “VMA” measurement. (Averaged over all the patterns found in the waveform.)
• Find the position of rising and falling edges in the input waveform.
• On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found (=End) and traverse backward until the

first point crossing the lower limit (20%) is found (= Start).
• On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found (=Start) and traverse forward until

the first point crossing the lower limit (20%) is found (=End).
• Compute Transition Time, TT = (End – Start) This value is averaged across all edges.
• End

Limits
Minimum value = 34 ps

Snapshot and cursor placement details
This measurement has two snapshots: first with cursors placed at the rise time, second with cursors placed at the fall time.

• Rise time: Zoom to the cursor positions. Cursor1 = starting point of RT of first rising edge, cursor2 = ending point of RT of first rising
edge.

• Fall time: Fall time: Zoom to the cursor positions. Cursor1 = starting point of FT of first falling edge, cursor2 = ending point of FT of first
falling edge.

Total jitter (Host)
TJ, as used here, is the Level 1 definition for Total Jitter as described in the FC-MJSQ, where TJ is the crossing width, defined as the late
time at which the BER is 10–12 minus the early time at which the BER is 10–12. This test is one of the SFF-8431 Table 12 Jitter and Eye
Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation
Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the PRBS31
pattern is valid.

Measurement procedure
Total jitter is measured using base DPOJET.

• Deskew the Data+ and Data- inputs. Compute the differential signal on Math1 = Dp – Dn.
• Use DPOJET TJ@BER measurement on the Math signal and Skew measurement on the single-ended input signals.

DPOJET settings
• Select Tab: Select Jitter > TJ@BER.
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• Configure the source:

• Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp – Dn)
• Select the Advanced check box and then set Reference Level % relative to Base Top as follows:

Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

• Click Close.
• Configure Tab:

• Edges: Signal Type = Data
• Clock Recovery:

• Method = PLL Custom BW
• PLL Model = Type II
• Damping = 700 m
• Loop BW = 4 MHz
• Click the Advanced Button:

• Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
• Known Data Pattern = OFF
• Click OK.

• RjDj:

For PRBS9 signal:

• Pattern Type = Repeating
• Pattern Length = 511 UI
• BER 1E– = 12 (for J2 BER 1E- = 2.6; for J9 BER 1E- = 9.6)

For PRBS31 signal:

• Pattern Type = Arbitrary
• Window length = 10 UI
• Population = 100
• BER 1E– = 12 (for J2 BER 1E- = 2.6; for J9 BER 1E- = 9.6)

• Filters: No filters
• General: OFF
• Global:

• Gating: OFF
• Quality: OFF
• Population: OFF

• Results Tab: In the Options menu, deselect Display Units – Absolute.
• Click Single.

Limits
Maximum value = 0.28 UI
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Snapshot and cursor placement details
No cursors are required because total jitter cannot be shown using cursors or snapshots. Instead, zoom a part of the waveform to see the
type of waveform used for the measurement. Zoom the waveform between time 0 and (Horizontal scale ÷ 104). If the record length is 2M,
the number of points in the zoomed part will be 200.

Data dependent jitter (Host)
DDJ is the range (max – min) of the timing variations measured on the Differential Signal with a crossing level equal to the average value
of the entire waveform being measured. The waveform is averaged sufficiently to remove the effects of random jitter and noise in the
system. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
Data dependent jitter is measured using base DPOJET.

• Deskew the Data+ and Data- inputs. Compute the differential signal on Math1 = Dp – Dn
• Use DPOJET DDJ measurement on the Math signal and Skew measurement on the single ended input signals.

DPOJET settings
• Select Tab: select Jitter, click DDJ.

• Source configuration:

• Source = Math 1 (Dp – Dn)
• Select the Advanced check box and then set Reference Level % relative to Base Top as follows:

Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

• Click Close.
• Configure Tab:

• Clock Recovery:

• Method = PLL-Custom BW

• PLL Model = Type II
• Damping = 700 m
• Loop BW = 4 Mhz

• Click the Advanced Button:

• Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
• Known Data Pattern = OFF
• Click OK.

• RjDj:

For PRBS9:
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• Pattern Type = Repeating
• Pattern Length = 511 UI
• BER 1E– = 12

For PRBS31:

• Pattern Type = Arbitrary
• Window length = 10 UI
• Population = 100
• BER 1E– = 12

• Filters: No filters
• General: OFF
• Global:

• Gating: OFF
• Quality: OFF
• Population: OFF

• Results Tab: In the Options menu, deselect Display Units – Absolute.
• Click Single.

Limits
Maximum value = 0.10 UI

Snapshot and cursor placement details
No cursors are required because data dependent jitter cannot be shown using cursors or snapshots. Instead, zoom a part of the waveform
to see the type of waveform used for the measurement. Zoom the waveform between time 0 and (horizontal scale ÷ 104). If the record
length is 2M, the number of points in the zoomed part will be 200.

Data dependent pulse width shrinkage (Host)
DDPWS is measured as the difference between one symbol period and the minimum of all the differences between pairs of adjacent
edges on the differential signal with a crossing level equal to the average value of the entire waveform being measured. The waveform is
averaged sufficiently to remove the effects of random jitter and noise in the system. This test is one of the SFF-8431 Table 12 Jitter and
Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The data dependent pulse width shrinkage measurement is performed using the algorithm library.

Inputs to algorithm
Differential waveform obtained on a Math channel using Data+ and Data– after deskewing.

Algorithm
• Input differential waveform.
• Estimate the UI of the waveform (UI = bit duration).
• Identify all the PRBS9 patterns found in the acquired signal.
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• Overlap all the PRBS9 patterns found in the acquisition to get a single averaged PRBS9 pattern.
• Identify the minimum width between adjacent edges of the averaged PRBS9 pattern. [= minimum UI]
• Compute Data Dependent Pulse Width Shrinkage (DDPWS) as: DDPWS = Estimated UI – minimum UI.

Limits
Maximum value = 0.055 UI

Snapshot and cursor placement details
This measurement has one zoomed snapshot with cursor1 and cursor2 marking the smallest UI.

Uncorrelated jitter (Host)
Uncorrelated jitter refers to the component of jitter in the transmitted signal that is not correlated to the transmitter data. The uncorrelated
jitter (rms) is given by the RMS value of the standard deviations of the two distributions, namely standard deviation of jitter on rising edge
and standard deviation of jitter on falling edge. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The uncorrelated jitter measurement is performed using the algorithm library.

Inputs to algorithm
• Differential waveform obtained on a Math channel using Data+ and Data– after deskewing
• Signal Type ("SFPPlus.SignalType")

Algorithm
• Input differential waveform.
• Identify the deviation of each rising and falling edge on the input signal from its ideal location (constructed using UI = 1÷ data rate)

(Note: consider the rising and falling edges of a pattern with the longest run of 1s to maintain some uniformity on the edges to
measure deviations. If the deviations were measured on all edges, then the deviations are inconsistent for different edges resulting in
measurement errors.)

• Find the standard deviation of the deviations of the rising edges. Find the standard deviation of the deviation of the falling edges.
• Compute UJ as follows:

where σr is the standard deviation of the jitter on the rising edge

where σf is the standard deviation of the jitter on the falling edge
• End

Output from algorithm
m_SFPPlusISDB.Result1Mean.Value = UJ.Mean
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Limits
Maximum value = 0.023 UI

Snapshot and cursor placement details
No cursors are required. Uncorrelated jitter cannot be shown using cursors or snapshots. Zoom a part of the waveform to see the type
of waveform used for the measurement. Zoom the waveform between time 0 and (horizontal scale ÷ 104). If the record length is 2M, the
number of points in the zoomed part will be 200.

Transmitter Qsq
Transmitter Qsq is measured on the differential data signal as the inverse of Relative Noise (RN). This test is one of the SFF-8431 Table
12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The transmitter Qsq measurement is performed using the algorithm library.

Inputs to algorithm
• Differential waveform obtained on a Math channel using Data+ and Data– after deskewing
• Signal Type ("SFPPlus.SignalType");
• Window Width (“SFPPlus.QsqWidth”);

Algorithm
• Input differential PRBS waveform
• Compute VMA as given by the VMA algorithm. On the input waveform, identify the regions with the pattern 11111111 or 00000000.
• On each such pattern, measure the AC RMS voltage in the 10% window where the waveform is the flattest.
• The AC RMS in the 11111111 regions is LevelONENoise, and that in 00000000 regions is

LevelZERONoise. Noise (rms) is measured as: 

• Measure Relative Noise as: 

The required result Tx Qsq is given by Tx Qsq = 1 ÷ RN
• End

Output from algorithm
m_SFPPlusISDB.Result1Mean.Value = TxQsq.Mean
m_SFPPlusISDB. Hist1Left.Value = LevelONEnoise window begin
m_SFPPlusISDB. Hist1Right.Value = LevelONEnoise window end
m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom for LevelONEnoise
Table continued…

SFP+ QSFP+ Tx tests

TekExpress® SFP+ QSFP+ Tx Compliance and Debug Solution Software Application Help 104



m_SFPPlusISDB.HorizontalScale1.Value = scale of Zoom that is to be set for LevelONEnoise
m_SFPPlusISDB. Hist2Left.Value = LevelZEROnoise window begin
m_SFPPlusISDB. Hist2Right.Value = LevelZEROnoise window end
m_SFPPlusISDB.HorizontalPos2.Value = position of the waveform where to zoom for LevelZEROnoise
m_SFPPlusISDB.HorizontalScale2.Value = scale of Zoom that is to be set for LevelZEROnoise

Limits
Minimum value = 50

Snapshot and cursor placement details
This measurement has two snapshots with zoom showing one full period of the 8180 pattern. The first snapshot has cursor1 and cursor2
marking the flattest region of the high part of the period. The second snapshot has cursor1 and cursor2 marking the flattest region of the
low part of the period.

Eye mask hit ratio (Host)
The required transmitter pulse shape characteristics are specified in the form of a mask of the transmitter eye diagram (used to measure
the number of Mask Hits). Eye mask hit ratio is computed using eye mask hit ratio = (Number of Mask Hits × Signaling Speed) ÷ (Number
of UIs × Sampling rate). This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other tests.

Signal validation
Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the PRBS31
pattern is valid.

Measurement procedure
Eye mask hit ratio is measured using base DPOJET.

• Deskew the Data+ and Data– inputs. Compute the differential signal on Math1 = Dp – Dn.
• Use DPOJET Mask Hits measurement on the Math signal and Skew measurement on the single-ended input signals.

DPOJET settings
• Select Tab: Select Eye >Mask Hits.

• Configure the Source:

• Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp–Dn)
• Select the Advanced check box and then set Reference Level % relative to Base Top as follows:

Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

• Click Close.
• Configure Tab:

• Edges: Signal Type = Data
• Clock Recovery:
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• Method = PLL – Custom BW
• PLL Model = Type II
• Damping = 700 m
• Loop BW = 4 MHz

• Click the Advanced button:

• Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
• Known Data Pattern = OFF
• Click OK.

• Click Apply.
• RjDJ:

For PRBS9 signal:

• Pattern Type = Repeating
• Pattern Length = 511 UI
• BER 1E– = 12

For PRBS31 signal:

• Pattern Type = Arbitrary
• Window length = 10 UI
• Population = 100
• BER 1E– = 12

• Filters: No filters
• General: OFF
• Global:

• Gating = OFF
• Quality = OFF
• Population = OFF

• Click Run.

Note: Run until population crosses 2M.

The Mask Hits DPOJET measurement gives the number of Mask hits. Plug that value into the following formula to obtain the Mask Hit
Ratio:

Mask Hit Ratio = Number of Mask Hits × Signaling Speed (10.3125 e9) ÷ Number of UIs (Population from DPOJET) × Sampling Rate
(50 e9)

Limits
Mask hit ratio of 5 x 10–5

Snapshot and cursor placement details
This measurement has one snapshot of the eye mask hit generated in DPOJET. No cursors are required.
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Host test: SFF-8431 table 33 tests

Voltage modulation amplitude (p-p)
Voltage modulation amplitude is measured as the difference between the nominal one and zero levels, which are defined as voltages
measured in the mid 20% of the high (eight 1s) and low (eight 0s) regions respectively, of the differential data signal. This test is one of the
SFF-8431 Table 33 Output Specifications at B for Cu tests.

Connect the equipment as shown in the diagram Connection Setup for Host Tests: All other Host tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The voltage modulation amplitude (p-p) measurement is performed using the algorithm library.

Inputs to algorithm
• Differential waveform obtained on a Math channel using Data+ and Data– after deskewing
• Signal Type ("SFPPlus.SignalType")

Algorithm
• Input differential PRBS waveform.
• On the input waveform identify the regions with the pattern 11111111 or 00000000.
• On each such pattern measure the mean voltage in the middle 20% of the pattern.
• The mean voltages corresponding to the Signal High regions is taken as vHigh and the mean voltages corresponding to the Signal Low

is taken as vLow. The vHigh and vLow values are averaged across all regions.
• The required result VMA is given by, VMA = vHigh – vLow
• End

Limits
Minimum value = 300 mV

Snapshot and cursor placement details
This measurement has one snapshot with cursor1 = +ve high of VMA, cursor2 = –ve high of VMA.

Transmitter Qsq (for Cu)
Transmitter Qsq is measured on the differential data signal as the inverse of Relative Noise (RN). RN is measured as RN = 2 × Noise
(rms) ÷ VMA. And Noise(rms) = Sq rt ( (LogicONENoise(rms)2 + LogicZERONoise(rms) 2 ) ÷ 2 ). This test is one of the SFF-8431 Table
33 Output Specifications at B for Cu tests.

Connect the equipment as shown in the diagram Connection Setup for Host Tests: All other Host tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The transmitter Qsq (for Cu) measurement is performed using the algorithm library.
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Inputs to algorithm
• Differential waveform obtained on a Math channel using Data+ and Data– after deskewing
• Signal Type ("SFPPlus.SignalType");

Algorithm
• Input differential PRBS waveform
• Compute VMA as given by the VMA algorithm. On the input waveform, identify the regions with the pattern 11111111 or 00000000.
• On each such pattern, measure the AC RMS voltage in the 10% window where the waveform is the flattest.
• The AC RMS in the 11111111 regions is LevelONENoise, and that in 00000000 regions is

LevelZERONoise. Measure Noise (rms) as: 

• Measure Relative Noise as:

The required result TxQsq is given by TxQsq = 1 ÷ RN
• End

Output from algorithm
m_SFPPlusISDB.Result1Mean.Value = TxQsq.Mean

Limits
Minimum value = 63.1

Snapshot and cursor placement details
This measurement has two snapshots with zoom showing one full period of the 8180 pattern. The first snapshot has cursor1 and cursor2
marking the flattest region of the high part of the period. The second snapshot has cursor1 and cursor2 marking the flattest region of the
low part of the period.

Output AC Common-Mode voltage (RMS) (for Cu)
Output AC common-mode voltage is measured as the AC RMS voltage of the common-mode ((DP + DN) ÷ 2) signal. This test is one of
the SFF-8431 Table 33 Output Specifications at B for Cu tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation
Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the PRBS31
pattern is valid.

Measurement procedure
The output AC common-mode voltage (RMS) (for Cu) measurement is performed using the base oscilloscope.

1. Math1 = (Dp + Dn) ÷ 2. Switch off channels connected to Dp and Dn.
2. Draw a histogram bounding box from top left of the oscilloscope to the bottom right and choose Histogram Vertical.
3. Select Math1 as the histogram source.
4. From the Measurement menu, select Histogram Measurements > Standard Deviation.
5. Do a single step run and measure the mean value of the histogram standard deviation. This is the measurement result.
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Limits
Maximum = 12 mV

Snapshot and cursor placement details
A screen shot where the histogram on math and the standard deviation value of the histogram is visible on the screen. The visible standard
deviation value should be the value shown in the report. No cursors are required.

Host output TWDPc

Note: The Host Output TWDPc test is supported only on oscilloscopes that support 100 Gs/s. For details, see Compatibility.

TWDP is a measure of the deterministic dispersion penalty due to a particular transmitter with reference emulated multi-mode fibers and
receiver. TWDP is initially defined to characterize the performance of a transmitter in optical links. The same concept has been extended to
quantify channel performance, especially in high-speed copper links.

This test is one of the SFF-8431 Revision 4.1 Table 33-Host Transmitter Output Specifications at B for Cu tests.

Note: The TWDPc measurement is supported only on a Ch1–Ch3 combination setup of a C or D series oscilloscope. 100 GS/s
RT mode output on Ch2 and Ch4 is not available. Therefore, if Ch1 is not working, the test cannot be performed successfully.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The Host output TWDPc measurement is performed using the algorithm library.

Inputs to algorithm
• Differential waveform obtained on a Math channel using Data+ and Data– after deskewing. Sampled at 3.3 TS/s using IT mode.
• Signal Type (“SFPPlus.SignalType”);

Algorithm
• Input the differential waveform (sampled at 3.3 TS/s IT)
• Down sample the differential input waveform to 16 samples per UI (which is down sampling 20 times)
• Identify all the PRBS9 patterns in the waveform. For each PRBS9 pattern, write all points to a text file and call the SFF8431 x WDP

algorithm.
• The required result TWDPc is the average value of the TWDP calculated for each PRBS9 pattern.
• End

Output from algorithm
m_SFFPlusISDB.Result1Mean.Value = Average TWDPc value

Limits
Maximum value = 10.7 dBe
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Module test: SFF-8431 table 16 tests

AC Common-Mode voltage tolerance (Module)
Output AC common-mode voltage tolerance is measured as the AC RMS voltage of the common mode ((DP+DN)÷2) signal. This is one of
the SFF-8431 Revision 4.1 Table 16 Module Transmitter Input Electrical Specifications at B' tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
Automatic signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the
PRBS31 pattern is valid.

Measurement procedure
AC common-mode voltage tolerance is measured using the base oscilloscope.

1. Generate the AC common-mode waveform on Math1 = (Dp + Dn) ÷ 2. Switch off the channels connected to Dp and Dn.
2. Add the base oscilloscope measurement Min and Max. Choose Math1 as the source in both cases.
3. Perform a single run and read theMin andMax values.

Limits
Min (Abs(Min), Abs(Max)) > 15 V (Table 16)

Snapshot and cursor placement details
A snapshot of the common-mode voltage is displayed on the oscilloscope.

Single-Ended input voltage tolerance (Module)
Single-ended input voltage tolerance is measured as the single-ended peak-to-peak input voltage for the positive and negative data
channels on a single acquisition. This test is one of the SFF-8431 Revision 4.1 Table 16 Module Transmitter Input Electrical Specifications
at B’ tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: Single-Ended Input Voltage Tolerance Test.

Signal validation
Automatic signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the
PRBS31 pattern is valid.

Measurement procedure
Single-ended input voltage tolerance is measured using base DPOJET.

• Use DPOJET measurement name: Ampl > Cycle Pk-Pk
• Use DPOJET settings: All default settings

Limits
For each of Dp and Dn:

• Minimum = –0.3 V
• Maximum = 4 V

Snapshot and cursor placement details
There will be two snapshots:
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• A snapshot of Dp with cursors placed at maximum and minimum voltages of single-ended Pk-Pk measurement value of Dp. Cursor
values can be derived using DPOJET: Ampl > Cycle Max and Ampl > Cycle Min for +ve and –ve peak, respectively for Dp.

• A snapshot of Dn with cursors placed at maximum and minimum voltages of single-ended Pk-Pk measurement value of Dn. Cursor
values can be derived using DPOJET: Ampl > Cycle Max and Ampl > Cycle Min for +ve and –ve peak, respectively for Dn.

Module test: SFF-8431 table 17 tests

Crosstalk source Rise/Fall time (20% - 80%) (Module)
Crosstalk source rise/fall time is measured as the 20% – 80% (of VMA) Rise time and 80% – 20% (of VMA) Fall time of the differential
crosstalk source introduced to the signal. This test is one of the SFF-8431 Table 17 Module Transmitter Input Tolerance Signal Calibrated
at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The crosstalk source rise/fall time (20% – 80%) measurement is performed using the algorithm library.

Inputs to algorithm
• Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying 12 GHz filter
• Signal Type ("SFPPlus.SignalType")

Algorithm
• Input differential waveform.
• Obtain values of vHigh and vLow as done in the VMA measurement (averaged over all the patterns found in the waveform).
• Find the position of rising and falling edges in the input waveform.
• On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found (= End) and traverse backward until

the first point crossing the lower limit (20%) is found (= Start).
• On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found (= Start) and traverse forward until

the first point crossing the lower limit (20%) is found (= End).
• Transition time is computed as TT = (End – Start). This value is averaged across all edges.
• End

Limits
Target value = 34 ps

Snapshot and cursor placement details
This measurement has two snapshots: the first with cursors placed at the rise time, the second with cursors placed at the fall time.

• Rise time: Zoom to the cursor positions. Cursor1 = starting point of RT of first rising edge, cursor2 = ending point of RT of first rising
edge.

• Fall time: Zoom to the cursor positions. Cursor1 = starting point of FT of first falling edge, cursor2 = ending point of FT of first falling
edge.

Cursor values and zoom positions are provided by the Algorithm library.
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Crosstalk source amplitude (p-p differential) (Module)
Crosstalk source amplitude is measured as the difference between the nominal one and zero levels, which are defined as voltages
measured in the mid 20% of the high (eight 1s) and low (eight 0s) regions respectively, of the differential crosstalk source introduced to the
signal. This is one of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The crosstalk source amplitude (p-p differential) measurement is performed using the algorithm library.

Inputs to algorithm
Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying 12 GHz filter

Algorithm
• Input differential PRBS waveform.
• On the input waveform, identify the regions with the pattern 11111111 or 00000000.
• On each such pattern, measure the mean voltage in the middle 20% of the pattern.
• The mean voltages corresponding to the Signal High regions is taken as vHigh, and the mean voltages corresponding to the Signal

Low is taken as vLow. The vHigh and vLow values are averaged across all regions.
• The required result amplitude is given by, Amplitude = vHigh – vLow.
• End

Limits
Target value = 1000 mV

Snapshot and cursor placement details
This measurement has one snapshot with cursor1 = +ve high of VMA, cursor2 = –ve high of VMA.

Output AC Common-Mode voltage (RMS) (Module)
Output AC common-mode voltage is measured as the AC RMS voltage of the common-mode ((DP + DN)÷2) signal. This test is one of the
SFF-8431 Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the PRBS31
pattern is valid.

Measurement procedure
Output AC common-mode voltage (RMS) is measured using the base oscilloscope.

1. Math1 = (Dp + Dn) ÷ 2. Switch off channels connected to Dp and Dn.
2. Draw a histogram bounding box from the top left of the oscilloscope to the bottom right, and choose Histogram Vertical.
3. Select Math1 as the histogram source.
4. From the Measure menu, select Histogram Measurements > Standard Deviation.
5. Do a single step run and measure the mean value of the histogram standard deviation. This is the measurement result.
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Limits
Maximum = 15 mV (Table 17)

Snapshot and cursor placement details
A snapshot where the histogram on math and the standard deviation value of the histogram is visible on the screen. The standard
deviation value visible on the screen should be the value reported in the report. No cursors are required.

Total jitter (Module)
Total jitter, as used here, is the Level 1 definition for TJ as described in the FC-MJSQ, where TJ is the crossing width, defined as the late
time at which the BER is 10–12 minus the early time at which the BER is 10–12. This test is one of the SFF-8431 Revision 4.1 Table 17
Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the PRBS31
pattern is valid.

Measurement procedure
Total jitter is measured using base DPOJET.

• Deskew the Data+ and Data- inputs. Compute the differential signal on Math1 = Dp – Dn.
• Use DPOJET TJ@BER measurement on the Math signal and Skew measurement on the single ended input signals.

DPOJET settings
• Select Tab: Select Jitter, click TJ@BER.

• Configure the source:

• Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp – Dn)
• Select the Advanced check box and then set Reference Level % relative to Base Top as follows:

Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

• Click Close.
• Configure Tab:

• Edges: Signal Type = Data
• Clock Recovery:

• Method = PLL-Custom BW
• PLL Model = Type II
• Damping = 700 m
• Loop BW = 4 MHz
• Click the Advanced Button:

• Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
• Known Data Pattern = OFF
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• Click OK.
• RjDj:

For PRBS9 signal:

• Pattern Type = Repeating
• Window length = 511 UI
• BER 1E– = 12 (for J2 BER 1E- = 2.6; for J9 BER 1E- = 9.6)

For PRBS31 signal:

• Pattern Type = Arbitrary
• Window length = 10 UI
• Population = 100
• BER 1E– = 12 (for J2 BER 1E- = 2.6; for J9 BER 1E- = 9.6)

• Filters: No filters
• General: OFF
• Global:

• Gating: OFF
• Quality: OFF
• Population: OFF

• Results Tab: In the Options menu, deselect Display Units – Absolute.
• Click Single.

Limits
Maximum value = 0.28 UI

Snapshot and cursor placement details
No cursors are required because total jitter cannot be shown using cursors or snapshots. Instead, zoom a part of the waveform to see the
type of waveform used for the measurement. Zoom the waveform between time 0 and (Horizontal scale ÷ 104). If the record length is 2M,
the number of points in the zoomed part will be 200.

Data dependent jitter (Module)
DDJ is the range (max – min) of the timing variations measured on the differential signal with a crossing level equal to the average value of
the entire waveform being measured. The waveform is averaged sufficiently to remove the effects of random jitter and noise in the system.
This test is one of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
Data dependent jitter is measured using base DPOJET.

• Deskew the Data+ and Data- inputs. Compute the differential signal on Math1 = Dp – Dn
• Use DPOJET DDJ measurement on the Math signal and Skew measurement on the single ended input signals.

DPOJET settings
• Select Tab: select Jitter, click DDJ.
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• Source configuration:

• Source = Math 1 (Ch1 – Ch1)
• Select the Advanced check box and then set Reference Level % relative to Base Top as follows:

Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

• Click Close.
• Configure Tab:

• Clock Recovery:

• Method = PLL-Custom BW

• PLL Model = Type II
• Damping = 700 m
• Loop BW = 4 MHz

• Click the Advanced Button:

• Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
• Known Data Pattern = OFF
• Click OK.

• RjDj:

For PRBS9:

• Pattern Type = Repeating
• Window length = 511 UI
• BER 1E– = 12

For PRBS31:

• Pattern Type = Arbitrary
• Window length = 10 UI
• Population = 100
• BER 1E– = 12

• Filters: No filters
• General: OFF
• Global:

• Gating: OFF
• Quality: OFF
• Population: OFF

• Results Tab: In the Options menu, deselect Display Units – Absolute.
• Click Single.

Limits
Target value = 0.10 UI
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Snapshot and cursor placement details
No cursors are required because Data Dependent Jitter cannot be shown using cursors or snapshots. Instead, zoom a part of the
waveform to see the type of waveform used for the measurement. Zoom the waveform between time 0 and (Horizontal scale ÷ 104). If the
record length is 2M, the number of points in the zoomed part will be 200.

Data dependent pulse width shrinkage (Module)
DDPWS is measured as the difference between one symbol period and the minimum of all the differences between pairs of adjacent
edges on the Differential Signal with a crossing level equal to the average value of the entire waveform being measured. The waveform
is averaged sufficiently to remove the effects of random jitter and noise in the system. This is a SFF-8431 Revision 4.1 Table 17 Module
Transmitter Input Tolerance Signal Calibrated at B” test.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The data dependent pulse width shrinkage measurement is performed using the algorithm library.

Inputs to algorithm
Differential waveform obtained on a Math channel using Data+ and Data– after deskewing.

Algorithm
• Input differential waveform.
• Estimate the UI of the waveform (UI = bit duration).
• Identify all the PRBS9 patterns found in the acquired signal.
• Overlap all the PRBS9 patterns found in the acquisition to get a single averaged PRBS9 pattern.
• Identify the minimum width between adjacent edges of the averaged PRBS9 pattern. [= minimum UI]
• Compute Data Dependent Pulse Width Shrinkage (DDPWS) as: DDPWS = Estimated UI – minimum UI.

Limits
Target value = 0.055 UI

Snapshot and cursor placement details
This measurement has one zoomed snapshot with cursor1 and cursor2 marking the smallest UI.

Uncorrelated jitter (Module)
Uncorrelated jitter refers to the component of jitter in the transmitted signal that is not correlated to the transmitter data. The uncorrelated
jitter (rms) is given by the RMS value of the standard deviations of the two distributions, namely standard deviation of jitter on rising edge
and standard deviation of jitter on falling edge. This test is one of the SFF-8431 Table 17 Module Transmitter Input Tolerance Signal
Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
For compliance, perform Signal Validation Procedure.

Measurement procedure
The uncorrelated jitter measurement is performed using the algorithm library.
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Inputs to algorithm
• Differential waveform obtained on a Math channel using Data+ and Data- after deskewing
• Signal Type ("SFPPlus.SignalType")

Algorithm
• Input differential waveform.
• Identify the deviation of each rising and falling edge on the input signal from its ideal location (constructed using UI = 1÷ data rate)

(Note: consider the rising and falling edges of a pattern with the longest run of 1s to maintain some uniformity on the edges to
measure deviations. If the deviations were measured on all edges, then the deviations are inconsistent for different edges resulting in
measurement errors.)

• Find the standard deviation of the deviations of the rising edges. Find the standard deviation of the deviation of the falling edges.
• Compute UJ as follows:

where σr is the standard deviation of the jitter on the rising edge

where σf is the standard deviation of the jitter on the falling edge
• End

Output from algorithm
m_SFPPlusISDB.Result1Mean.Value = UJ.Mean

Limits
Target value = 0.023 UI

Snapshot and cursor placement details
No cursors are required. Uncorrelated jitter cannot be shown using cursors or snapshots. Zoom a part of the waveform to see the type of
waveform used for the measurement. Zoom the waveform between time 0 and (H-scale ÷ 104). If the record length is 2M, the number of
points in the zoomed part will be 200.

Eye mask hit ratio (Module)
The required transmitter pulse shape characteristics are specified in the form of a mask of the transmitter eye diagram (used to measure
the number of Mask Hits). Eye Mask hit ratio is computed using Eye Mask hit ratio = (Number of Mask Hits × Signaling Speed) ÷ (Number
of UIs × Sampling rate). This test is one of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B”
tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module tests.

Signal validation
Automatic signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software assumes that the
PRBS31 pattern is valid.

Measurement procedure
Eye mask hit ratio is measured using base DPOJET.

• Deskew the Data+ and Data– inputs. Compute the differential signal on Math1 = Dp – Dn.

SFP+ QSFP+ Tx tests
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• Use DPOJET Mask Hits measurement on the Math signal and Skew measurement on the single-ended input signals.

DPOJET settings
• Select Tab: Select Eye, click Mask Hits.

• Configure the source:

• Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp – Dn)
• Select the Advanced check box and then set Reference Level % relative to Base Top as follows:

Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

• Click Close.
• Configure Tab:

• Edges: Signal Type = Data
• Clock Recovery:

• Method = PLL - Custom BW
• PLL Model = Type II
• Damping = 700 m
• Loop BW = 4 MHz

• Click the Advanced Button:

• Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
• Known Data Pattern = OFF
• Click OK.

• Click Apply.
• RjDj:

For PRBS9 signal:

• Pattern Type = Repeating
• Pattern length = 511 UI
• BER 1E– = 12

For PRBS31 signal:

• Pattern Type = Arbitrary
• Window length = 10 UI
• Population = 100
• BER 1E– = 12

• Filters: No filters
• General: OFF
• Global:

• Gating: OFF
• Quality: OFF

SFP+ QSFP+ Tx tests
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• Population: OFF
• Click Run..

Note: Run until population crosses 2M.

The Mask Hits DPOJET measurement gives the number of Mask hits. Plug that value into the following formula to obtain the Mask hit ratio:

Mask Hit Ratio = Number of Mask Hits × Signaling Speed (10.3125 e9) ÷ Number of UIs (Population from DPOJET) × Sampling Rate (50
e9)

Limits
Mask hit ratio of 5 x 10–5

Snapshot and cursor placement details
This measurement has one snapshot of the eye mask hit generated in DPOJET. No cursors are required.
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References

Application directories
You can find the application files at C:\Program Files\Tektronix\TekExpress SFP+ QSFP+. The application directory and associated files are
organized as follows:

The following table lists the default directory names and their usage:

Table 22: Application directories and usage

Directory names Usage

ACP Contains instrument and application specific interface libraries
Bin Contains application libraries
Compliance Suites Contains test suite specific files
Documents Contains the technical documents of the application.
Examples Contains various support files
ICP Contains instrument and application specific interface libraries
Images Contains images of the application
Lib Contains utility files specific to the application
Licenses Contains all the license files
Report Generator Contains style sheets for report generation
SCP Contains instrument and application specific interface libraries
Tools Contains instrument and application specific files
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File name extensions
The TekExpress SFP+ QSFP+ software uses the following file name extensions:

Table 23: File name extension

File name extension Description
*.TekX Application session files (the extensions may not be displayed)
*.py Python sequence file.
*.xml Test-specific configuration information (encrypted) files.

Application log files

*.csv Test result reports

Plot data

*.mht Test result reports (default)

Test reports can also be saved in HTML format

*.pdf Test result reports

Application help document

*.xslt Style sheet used to generate reports
*.png Captured images
.wfm Test waveform file

View test-related files
Files related to tests are stored in My Documents\TekExpress SFP+ QSFP+\Untitled session folder. Each test setup in this folder has both
a test setup file and a test setup folder, both with the test setup name. The test setup file is preceded by the TekExpress icon.

Inside the test setup folder is another folder named for the DUT ID used in the test sessions. The default is DUT001.

Inside the DUT001 folder are the session folders and files. Each session also has a folder and file pair, both named for the test session
using the naming convention (date)_(time). Each session file is stored outside its matching session folder:

Each session folder contains image files of any plots generated from running the test session. If you selected to save all waveforms or ran
tests using prerecorded waveform files, these are included here.

References
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The first time you run a new, unsaved session, the session files are stored in the Untitled Session folder located at X:\TekExpress SFP+
QSFP+. When you name and save the session, the files are placed in a folder with the name that you specify. A copy of the test files stay
in the Untitled Session folder until you run a new test or until you close the application.

De-embed using filter files
TekExpress SFP+ QSFP+ Tx provides an option to de-embed the signal path using filter files. You create the filter files. The filter files
are .flt files composed of de-embed filter coefficients for a particular sampling rate. A filter file created for one sampling rate might not work
for other sampling rates, so it is important to understand at what sampling rate the measurements are being performed. The following table
summarizes the sampling rates used for each measurement.

Table 24: Measurement sampling rates

Measurement Oscilloscope model
DPO/DSA/MSO C, D, DX, and SX Series (>16 GHz BW)
Input on Ch1 and Ch3

Single-Ended Output Voltage Range 100 GS/s
Output AC Common Mode Voltage (RMS)
Host Transmitter Jitter and Eye Mask specifications
Crosstalk Source Rise/Fall Time (20% – 80%) 100 GS/s
Crosstalk Source Amplitude (p–p differential)
Signal Rise/Fall Time (20% – 80%)
Total Jitter (p–p)
Data Dependent Jitter (p–p)
Data Dependent Pulse Width Shrinkage (p–p)
Uncorrelated Jitter (RMS)
Transmitter Qsa
Eye Mask Hit Ratio
Host Transmitter Output Specifications for CU (SFP+ Host supporting direct attached cables)
Voltage Modulation Amplitude (p–p) 100 GS/s
Transmitter Qsa
Output AC Common Mode Voltage
Host Output TWDPc 3.3 TS/s

Deskew channels
If skew is present between positive and negative channels, then the channels need to be deskewed before being used for waveform
measurements. TekExpress SFP+ QSFP+ Tx provides support for channel deskew using the following method:

1. Determine what the skew is for each channel.
2. From the TekScope menu, select Vertical > Deskew.
3. In the Deskew/Attenuation window, click the channel (1 – 4) button for the first channel to be deskewed.
4. Click in the Ch(x) Deskew Time entry field and enter the skew. The skew can be +ve or –ve.
5. Click the channel button for the next channel and repeat step 4.
6. After entering the skew for all the channels that require it, from the Options menu in TekExpress SFP+ QSFP+ Tx, select Deskew.
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7. In the Deskew dialog box, select the desired level:

• Less than 100 mV signal amplitude: Select this if the signal amplitude is such that the oscilloscope’s vertical setting is less than
100 mV/division.

• 100 mV or greater signal amplitude: Select this if the signal amplitude is such that the oscilloscope’s vertical setting is greater
than 100 mV/division.

8. Click Read Deskew/Attn.
9. When the status in the dialog box indicates the deskew is finished, click Close.

Each input channel has its own deskew settings. Deskew compensates individual channels for probes or cables of different lengths. The
instrument applies the delay values after each completed acquisition. The deskew values are saved as part of the instrument setup. The
deskew values for the selected channel are retained until you change the probe, you restore a saved setup, or you recall the factory setup.

Map the My TekExpress folder
Follow these steps to map the My TekExpress folder on the instrument:

1. Open Windows Explorer.
2. From the Windows Explorer menu, click Computer.
3. In the menu bar, select Map network drive.
4. Select the Drive letter as X: (if there is any previous connection on X:, disconnect it first through Tools > Disconnect Network drive

menu of Windows Explorer. Windows 7 users: if you do not see the Tools menu, press the Alt key).
5. In the Folder field, enter the remote My TekExpress folder path (for example, \\192.158.97.65\ My TekExpress).

To determine the IP address of the instrument where the My TekExpress folder exists, do the following:

1. On the instrument where the My TekExpress folder exists, click Start and select Run.
2. Type “cmd” and then press Enter.
3. At the command prompt, type “ipconfig” and then press Enter.
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